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About This Booklet

This booklet was compiled in response to student and faculty requests for an introduction to the Publication
Manual of the American Psychological Association, 6th edition, better known as “the APA manual.”

The booklet is not intended to replace the standard APA manual but rather to help you interpret the manual
and to call your attention to some of its most important features. In addition, the booklet provides such help
as word processing instructions and writing tips to supplement the APA manual.

Throughout the booklet you will see bracketed numbers. These refer to relevant sections of the Publication
Manual.

Please note that this booklet is not formatted in APA style. | have used APA style where possible, but APA
was designed for academic papers, not "how-to" manuals. Furthermore, | strove for an informal,
conversational style not reflective of standard academic discourse. As a consequence, you will see many
departures from APA style and formatting.

If you want to suggest ways to make the booklet more helpful, | would appreciate hearing from you. You
can reach the Writing Center using the contact information on the last page.

Chery( Prentice

Director, The Writing Center

Saint Mary’s University of Minnesota

School of Graduate & Professional Programs

( Symbols \
n = Frequently asked question * = Especially helpful tip

The numbers in brackets [xx] throughout the booklet refer to relevant sections
of the standard APA manual.

\You will find a detailed index at the back of booklet. )
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PART ONE: INTRODUCTION TO THE APA
WHAT IS APA?

APA is not a government agency, a sexually transmitted disease, a sports drink, a hair gel, or a California
spiritualist movement. APA stands for “American Psychological Association.” Outside the field of
psychology, “APA” is shorthand for the writing style manual published by the APA: The Publication Manual
of the American Psychological Association.

What is a style manual and who needs one?

Many academic disciplines and professional fields such as law, chemistry, computer science, languages and
literature, and medicine have developed their own style manuals (The Bluebook, ACS, IEEE, MLA, and
AMA, respectively) . These manuals support the unique research and writing methods of each discipline
and profession. Style manuals reduce misunderstandings by setting consistent guidelines recognized by
readers all over the world.

The American Psychological Association developed its manual to guide researchers, writers, and readers
through a science-based method of inquiry. It is intended to support the underlying principles of objectivity,
transparency, ethics, and clarity. Because the APA style has worked well, it has been adopted in other
fields--notably education, business, and undergraduate nursing—that share similar research protocols.

Why so many guides? Why can’t everyone use the same one?

The research and writing for one academic discipline may require a style that does not meet the needs of
other disciplines or professions. You can understand how a professor of French literature, for example,
might require a set of stylistic guidelines different from those of a chemist or neurosurgeon.

Saint Mary’s University has adopted the APA as the official style manual for its School of Graduate and
Professional Studies. (SMU medical students use the AMA.) Use of the APA ensures that SMU students
have a solid stylistic foundation for their academic and professional writing.

What’s in the APA that | need to know?

e The "Writing Clearly and Concisely” section (pp. 61-84) is an excellent guide to getting ideas across
clearly, effectively, and objectively.

e "Mechanics of Style” section (pp. 87-114) lays out the rules of punctuation, spelling, and
capitalization, among other things, as they apply in your discipline. No guesswork.

e The "Crediting Sources" section (pp. 169-189) explains methods for documenting credible research
sources in an academically ethical way.

e The "Reference Examples" section (pp. 193-244) provides dozens of examples for listing sources
on your reference page in such as way that readers can identify and retrieve them.

e The index (pp. 259-272) helps you locate specific information in the manual.

FORMATTING BASICS FOR AN APA PAPER

For word processing instructions, see "Using Microsoft Word for APA Tasks" in this booklet.

Check to see if your program requires departures from APA style
ALIGNMENT

Alignment is set at the left margin only for all text except some headings and the title page. Text should
align evenly on the left margin but ragged on the right margin, like the text on this page. Indent the first line
of a paragraph % inch (1 Tab).

FONT (TYPEFACE) [8.03]

The standard font for student papers at Saint Mary's University SGPP is Times New Roman size 12. (The
text you are reading now is 9-point Arial). Do not use underlining or all capitals unless your instructor
specifies these. Use boldface for headings only. Keep the font the same throughout the paper unless your
instructor tells you otherwise.

©The Writing Center, Saint Mary's University of Minnesota Schools of Graduate & Professional Programs 1




HEADINGS [3.02-3.03]

Headings help both the reader and the writer follow the paper's organizational structure, and good writers
use them. APA headings are boldfaced and follow a simple pattern of 5 levels, as illustrated in the APA
manual.

INDENTS [8.03]

Indent the first sentence of each paragraph ¥z inch (one Tab space). All other lines of the paragraph wrap to
the left margin, as in this paragraph. Indent blocked quotes (40 words or more) % inch on the left side only,
including the first sentence. Do not indent the first line of the abstract. For reference page entries create
hanging indents as explained in this booklet under "Using MS Word for APA." See examples in APA pp.
50-51.

LINE SPACING [8.03]

Double-space all lines in the paper, including references and blocked quotes, unless your instructor
specifies otherwise. The first line of each page (except title page) begins at the top margin. Maintain one
double space after headings and between paragraphs.

Use the double-space setting of the word processor. Do not double-space manually by pressing the Enter
key twice between lines

MARGINS [8.03]

Set margin at 1 inch on all sides. (Doctoral students use 1.5 left margin.) Many word processors set the
default margin at 1.25, so you may need to reset the margins to 1 inch.

PAGE NUMBERS [8.03, p. 230]

Count the title page as page 1 of the document. Place page numbers at the top right corner, % inch from the
top (inside the header). If your program requires a running head, place it inside the header at the left hand
margin, ¥z inch from the top edge. Use the word processor's automatic settings rather than typing the page
number and header on each page. (For word processing instructions see "Using MS Word for APA" section
of this booklet.) For an illustration of page numbers and running heads, see the sample papers in the APA
manual, pp. 41-60.

PAPER [5.01]

Use 8-1/2” x 11” white paper. All papers are word-processed, one side only.

SPACING AFTER PUNCTUATION [4.01]

In general, insert 1 space after every mark of punctuation,* but APA recommends that you in insert 2
spaces after punctuation that ends a sentence. Exceptions: No space inside quotation marks and
parentheses. Note the following examples:

Byer advocated a “go-it-alone” position in the conflict.
Cole introduced the proposal (as recommended) and took a vote.

See also Wiederkehr, S. (2009, July 30). On two spaces following a period [APA Web log post]. Retrieved
from http://blog.apastyle.org/apastyle/2009/07/on-two-spaces-following-a-period.html

TITLE PAGE

The title page in the APA manual is intended for the submission of a manuscript for publication and may not
serve to identify college papers. If your program has not provided a model for a title page, use the example
provided in this booklet.

Does APA require a page number on the title page? [p. 41]
Yes, the APA illustrates both a page number and running head inside the header of the title page and
on all subsequent pages. Follow the example unless instructed otherwise by your program guidelines.

For word processing instructions, see "Using Microsoft Word for APA Tasks" in this booklet.
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What to Include on a Title Page

The APA manual describes a title page for a manuscript submitted for publication. That style of title page is
not necessarily appropriate for student papers. If your program or your instructor gives you a sample title
page, use that. Otherwise use the sample text provided below.

Double-space the text and center it horizontally using the word processor's Center text command.

Place the running head and the page number inside the header, ¥z inch from the top edge of the
paper.

Insert the header and page number automatically (see "Using Microsoft Word 2007 for APA" in
this booklet). Do not type page numbers manually.

If your program prefers no page number or header on the first page, leave them off; however, you
should count the title page as the first page even if you don't print the number on it.

Set margins and font (size and type) on the title page to match the rest of paper. Do not use
boldface, italics, or underline.

Center the text vertically on the page. To force the next new page, Insert Page Break

NOTE: Masters of Education and Education Leadership students should follow title page templates
posted on the Writing Center’s website at www.smumn.edu/tcwrite .

Attachment Disorder: The Importance of Facial Expressions
Bv
Flzzmorz (). Bogwart
Saint Marv's University of hMinnssota
Schools of Graduats and Professional Programs
PSY690 Early Childhood Development
C. C. Bazidjans, Instructor

Mawv 16 2010

- h...‘_ﬁ.*;‘_...._“"%_w ',. ‘."-.«...___'-J\ Ly s - ‘.\__‘.“Lh-—"-'
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PLAGIARISM [1.10, 6.01-602]

Plagiarism is a serious academic offence. A few students plagiarize in an attempt to cut corners or to cover
academic deficiencies. Other students, unfortunately, plagiarize because they don't understand the concept
of plagiarism and the methods for avoiding it. In either case, students are held accountable for their actions,
and the penalty could be as severe as dismissal from the institution. Follow the rules of citation and
documentation carefully, and make sure you understand what is meant by paraphrasing.

In APA style, a citation consists of author’s last name and date of publication. A full citation appears on the
References page.

Most universities, including Saint Mary’s University of Minnesota, impose penalties on students or staff who
plagiarize, whether the plagiarism is deliberate or inadvertent.

Avoiding Plagiarism
Plagiarism is the presentation of someone else’s work as your own. If you use
another author’s words you must attribute the work to its original source (its
author, composer, etc.).

e If you borrow an idea from, or directly quote from, another person’s
work, cite the source of that idea or quote.

e Phrases borrowed word-for-word from another author must be placed
in quotation marks and followed by the page number from the original
source.

e Cite a source even if you don’t quote directly from it.

e Paraphrase with care. Inadequate paraphrasing can be another form of
plagiarism, even with documentation provided.

For more tips on avoiding plagiarism, go to the Writing Center website at

www.smumn.edu/tcwrite

QUOTING AND PARAPHRASING [1.10, 6.03-6.10]

See APA manuals for details.

QUOTATIONS [6.03, 6.05-6.09]

A. How can | use direct quotes effectively?

In a word, sparingly. You could probably write a better paper if you didn’t use any. Direct quotes can be
problematic because

e Text lifted from its original context can be misunderstood in the context you provide in your paper.
Sometimes the meaning or intent of the quote is changed by the new context.

¢ Quoting provides no indication of how well, or even if, you understand the material you are quoting.
Overuse of quotes therefore can cause you to lose credibility with your readers.

e Quoting, if not done very skillfully, can break up the flow of your writing. Suddenly encountering
another person’s writing style can be jarring to readers.

If you do quote, have a good reason to do so: for example,

to discuss the way an author expressed his or her ideas,

to present a controversial or disputed statement verbatim,

to convey precise technical data or directions,

to produce a rhetorical effect when introducing or emphasizing a point.
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Remember:

e Quoted text of fewer than 40 words must be enclosed in quotation marks and followed by the page
number of the original text;

e  Quotations of 40 words or more must be blocked—fully indented %2 inch from the left margin but not
enclosed by quotation marks;

e If you use a blocked quote, always provide your own interpretation or other commentary along with
it.

B. Quotation of Fewer than 40 Words. Keep within paragraph text.

Phenix and Scott-Dunn (1991) stated, “There is clearly a need for a new kind of spelling
instruction, one that raises students’ awareness about language and its patterns, and focuses
on word construction rather than word memorization” (p. 26).

[Note page number outside quotation marks and period after parentheses.]

Jones and Smith (1992) described “the soci fuction of word families as a powerful tool
in spelling instruction” (p. 415).

C. Quotation of 40 or More Words. Place in separate, indented ("Blocked") paragraph.

Swicegood (1994) linked the use of portfolios with the Individual Education Plan (IEP) when
he stated the following:
Insight gained through informal, ecological approaches gives teachers access to viable
information, which in turn leads to more effective interventions and practices, both in
schools and clinical settings. The use of student portfolios in placement and
instructional planning contexts, including the design of IEP goals and objectives, can
add depth and breadth to the intervention process.'(& 14)

Note that the indentation of the quote replaces quotation marks and that the
period is placed at end of quote rather than after the parenthesis of page

D. Capitalization of Quotations*

1. If the quote is a complete sentence, capitalize the first word.

Harris (2000) remarked, “Finding information is an art, not a science” (p. 214).

According to Plotnik (1982), “The licensing or copyright agreement with the author does
not cover items the author borrowed from another source” (p. 16).

2. However, if the quoted text is not a complete sentence or if a quoted sentence follows the
word that, do not capitalize the first word or precede it with a comma. [See examples, pp. 171-
172]

Sutter (1998) was fascinated with Lake Superior's ore boats and foreign freighters
because they “seemed impossibly exotic” (p. 2).

Quincy (2000) acknowledged that “negotiations over bride price sometimes involved
more than the price of the bride” (p. 105).

3. Do not capitalize the first word of a quoted phrase (incomplete sentence).

Bryson (2002) called the English language “a merry confusion of quirks and irregularities
that often seem willfully at odds with logic and common sense.”

4. If the quote is interrupted, do not capitalize the first word of the resumed quote.

“People and places,” noted Zinsser, “are the twin pillars on which most nonfiction is
built” (p. 54).

* Sources: Hacker, D. (2003) A writer’s reference, p. 284. Boston: Bedford St. Martins.
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Harris, M. (2000). Prentice Hall reference guide to grammar and usage (4" ed.), p. 229. Upper Saddle River,
NJ: Prentice Hall.

How should | format quoted material that is not in APA style?

Section 3.35 (p. 118) of the APA manual states that direct quotations must adhere to the wording, spelling,
and interior punctuation of the original source. But what about formatting—for example, of bullets?
According to a member of the APA Style Expert staff,

This is a question about which there does not seem to be complete agreement

. in the ranks. However, in my opinion, when quoting material, . . . keeping bullets rather than
changing them to enumerated paragraphs is the way to go. The author undoubtedly had a choice
between bullets and enumerated paragraphs when writing the original work, so it is good form to
respect that choice when quoting the work, if it is possible to do so. (Personal communication,
November 7, 2002)

To indent block quotes see section entitled “Using Microsoft Word for APA Tasks” in this booklet.

PARAPHRASES

Perhaps paraphrasing is best defined by what it is not. Changing or omitting a few words of another
author’s statements in order to avoid a direct quote is not paraphrasing; it is, to be blunt, a form of
plagiarism. Readers are led to believe that you are presenting your understanding of another author’s
words, when in fact you are using that author’s actual words (mostly). Paraphrasing requires that you
express ideas in your own terms. Of course, you will use some of the same terminology as the original
author. If you are writing about corporate downsizing, for example, you can’t avoid that term. However, if
you simply parrot the original author’s sentence structure, style, and diction, then you are not paraphrasing.

Here’s a strategy for paraphrasing: Read a section of the text you plan to reference, put the text aside, and
write your own interpretation in your own words. If you can’t do it, you need to reread the text for better
understanding before you try again. Sometimes reading aloud is helpful.

Following are examples of how to paraphrase, and how not to paraphrase.

The Original (Source: Quincy, K. (1995). Hmong: History of a people. Cheney, WA: Eastern
Washington University Press)

Vietnamese tradition wisely forbade the confiscation of land for the payment of debts, but the
French ignored this tradition. A peasant's land was treated like any other real asset that could be
seized for the payment of debts. Fearing the confiscation of their land for non-payment of taxes,
many peasants turned to wealthy Vietnamese for loans (at interest rates that often exceeded 100%
per annum) to meet their tax obligation in a futile attempt to stall off the inevitable. Slowly but
surely Vietnam was transformed into a land of huge estates on which approximately seventy
percent of the population toiled as sharecroppers. French tax policy was exploitative and
shortsighted. Within two generations it created the social and economic conditions for
revolution. (p. 114)

In the following paragraph an attempt has been made to paraphrase the paragraph. The phrases in
boldface are identical to those in the original

Poor Paraphrase

Vietnamese tradition di ing of land for the payment of debts. The
French, however ignored th nd treated land like any other asset. Fearing the
loss of their property, many peasants went to wealthy Vietnamese for loans at high interest
rates. Eventually, Vietnam was€hanged into a collection of huge estates, where nearly
three-fourths of the people arecroppers. The tax policy of the French was
unfair and misguided, and it"set the stage forwevolution (Quincy, 1995).

Most of this unacceptable "paraphrase" consists of identical words in the identical grammatical form of the
original. Even if the paraphraser were to find synonyms for the original words, the passage would still be a
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plagiarism because the pattern of expression is the same. Now compare the paragraph above to an
acceptable paraphrase below, in which the ideas are summarized and expressed in a new way.

Paraphrase (one possibility)

Quincy (1995) described how destitute Vietnamese peasants had to sell off their small
landholdings to pay for heavy taxes imposed by the French. Wealthy Vietnamese then bought the
small plots and consolidated them into large estates on which the peasants had to work as
sharecroppers. It was the "exploitative and shortsighted" French tax policies, Quincy concluded,
that planted the seeds of political and social upheaval in Vietham (p. 114).

If you believe that some of the author's key words ought to be retained (in this example, his words describing
French tax policy), then quote only those words in your paraphrase; but provide a page number for the
quoted words. If quoted words are included, the author's name should precede them

NOTES
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THE BASICS OF CITING SOURCES

Why Do We Cite Sources?

Why are we asked to use and cite scholarly sources in academic writing? There are three reasons, and
understanding these help us what sources to cite and how to document them.

Reason 1: Academic Ethics. Honesty and fairness require us to let readers know whose ideas or words
we have borrowed. We can’t pass off someone else’s work as our own. Simply changing a few words to
avoid a direct quote doesn’t remove our obligation to identify the source. No matter how we word it,
someone else’s idea still needs to be identified.

Reason 2: Scholarly Credibility. Even new research needs to be founded on, or related to, existing
scholarly work. We must establish credibility and provide context for our ideas, indicating our knowledge
about the topic. We need to relate our ideas to what has been written before by experts in the field.
Citations help identify those experts.

Reason 3: Source Retrieval. For various reasons, readers may want to view the sources we used in our
writing, whether we used those sources for background or quoted them directly. Our responsibility as
writers is to provide sufficient documentation in a systematic way so that readers can retrieve the
information we used.

Sources are Cited in Two Places:

1. Give a short citation (author last name and year of publication) in the body of your paper, by author’s
last name and year (in parentheses). The purpose of citing sources in the body of you paper is to
lead readers to the full citation on the reference page at the end of the document.

2. Give a full citation on the reference page at the end of your document, where you will provide (a)
author, (b) publication date, (c) title, and (d) publisher information (see "Sample Reference Page").
The citations are listed in alphabetical order by author’s last name.

How to Begin

Writing Center staff members recommend that you compose your reference list as you do your research.
Here is why:

1. Composing the APA reference entry helps you understand your source—who wrote it, when it was
published, and who published it.

2. When you compose your reference list entry, you will recognize immediately if a crucial piece of
source information is missing. You can then decide whether to locate the missing information or
avoid using the source.

3. You will know how to cite the source briefly in the body of your paper. The first two elements of the
reference list entry tell you how to write the brief citation in the paragraphs of your paper.

Timesaving Advice

e All academic databases (e.g., EBSCO, Academic Search Premier, ProQuest Education Journals,
PsycINFO) provide the information you need to create an APA reference for any source you
retrieve from the database. (Sources retrieved from Google may not provide that information.)

e Many electronic academic databases provide pre-formatted APA references that you can copy
and paste to your own reference page. Some of the references may contain minor APA errors
that will require formatting adjustments on your part, but copying the references willl save you lots
of time in comparison to typing all the reference information yourself.

e You will find more information in this book to help you locate, copy, paste, and correct thes pre-
formatted database reference, and you can find instructional videos at
http://www2.smumn.edu/deptpages/tcwritingcenter/apa/apa_cite_tutorials.php

To copy electronic database citations directly to your reference page, see "Copy & Paste APA
References From A Database" in the word processing section of this book.
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PRIMARY & SECONDARY SOURCES [6.17]

A primary source is the originator of the information—the source in which the information was first
expressed or published. Sigmund Freud, for example, was the primary source for the information in his
work, Civilization and Its Discontents, written in 1930. If you had read his book you would cite it as follows:

Citation on Your Reference List
Freud, S. (1930). Das unbehagen in der kultur. City, Country: Publisher.

Citation in Your Paper

Freud (1930) . ..or ... (Freud, 1930).

Secondary Source: However, you almost certainly did not read that book because it was published in
Europe and written in German. Unless you are an advanced student or practitioner, you probably read
about Freud’s work in another publication—a textbook or other book like Breger's A Dream of Undying
Fame: How Freud Betrayed His Mentor and Invented Psychoanalysis. Breger would be a primary source
for his own ideas or opinions, but he would be a secondary source for Freud’s ideas (Freud is the primary
source for Freud's ideas.). If you cite Freud's ideas through Breger’s words, you would cite this way:

Citation on Your Reference List
Breger, L. (2009). A dream of undying fame : How Freud betrayed his mentor and
invented psychoanalysis. New York, NY: Norton.

Citation in Your Paper
Freud (as cited in Breger, 2009) . .. or ... (Freud as cited in Breger, 2009).

When to Use Secondary Sources

Avoid secondary sources when possible. With the availability of sources on the Internet and through
university libraries, most sources are retrievable. When you rely on a secondary source, you raise the
question of why you didn't seek the original. Furthermore, you are forced to rely on the interpretation of the
secondary source author. You will pass along any errors he or she made in presenting the primary source.
Use secondary sources when the primary source is not translated into English, when you need to discuss
reviews of the primary source material, or when the primary source information is not essential to your
purpose.

Translated Source: If you did read a primary source in a translation, you can still cite it as a primary source.
In that case of Freud, for example, you can site Freud as a primary source. However, you will need to
identify the translator and the re-publication date on your reference page. For your in-text citation, give both
the original publication date and the translation publication date.

Citation on Your Reference List
Freud, S. (2005). Civilization and its discontents (J. Strachey, Trans.) New York, NY:
Basic Books. (Original work published 1930)

Citation in Your Paper
Freud (1930/2005) . . . or ... (Freud, 1930/2005).
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FOUR ELEMENTS OF A REFERENCE PAGE ENTRY [6.27-6.31]

APA is easier to learn when you recognize patterns of rules. Instead of trying to remember dozens
individual citation examples, learn the four basic elements that comprise all source citations:

Rule 1. Each entry on an APA reference list contains four elements that identify the source for easy
retrieval. The four elements appear in the following order:

1. Author 2. Publication date 3. Title 4. Publisher information

In the following reference list entry for a journal article, the four elements are illustrated with shading:
1 2 3 4

Weissberg, R.  (2007). Oh to be rid of administrative wimps! = Academic Questions, 26(2), 146-149.

Rule 2. Each element ends with a period. Commas and other punctuation marks may appear within
an element. In the case of the Author element, the period after the author's initial serves as the final
period for the element.

Rule 3. The first two elements, Author and Date, determine how the source is cited in the body of
the paper. Therefore, it is best to create the reference page entry before citing the source in your text.

ELEMENT 1: THE AUTHOR ELEMENT (see also APA 6.27). The author may be (a) a single individual, (b)
several individuals working in collaboration, (c) an organization, (d) a corporation, (e) a government agency
or other group. Place a period at the end of the element, regardless of type of author. All the following are
examples of author elements:

American Cancer Society. [organization]

Ferris, D. [individual]

Internal Revenue Service. [government agency]

West, S., Beckman, T., Vonk, J., & Jett, S. E. [individuals in collaboration]

To cite the source in the body of your paper, give only last names—no initials. Spell out names of groups.

In the rare case in which an author of a source is not identified, move the work’s title into the position of
Author Element on the reference page and alphabetize by the title’s first word (skipping A, An, or The), To
cite the source in the body of your paper, substitute the first word of the title in place of the author's name,
typing that word either in italics or placing it inside quotation marks, depending of the type of title (see
below).

ELEMENT 2: THE DATE ELEMENT (see also APA 6.28). The date is usually expressed only as a year—
the year of publication—and is placed in parentheses after the Author Element. However, if a month and
day are provided—and if no volume number is given—include the month and day after the year. This
element cannot be left blank. If no publication year is provided, type the letters n.d. inside parentheses (but
without italics). Place a period at the end of the Date Element. Here are examples:

(2012). Year of Publication
(2008, May 19). Month and day provided by publisher, but no volume number provided
(n.d.). No publication date was provided by the publisher or web site

If you are not sure about the publication date, consult a librarian or a Writing Center consultant.

ELEMENT 3: THE TITLE ELEMENT (see also APA 6.29). Title Elements can be of two types: () title of a
work published inside another work (for example, a chapter inside a book or an article inside a journal); or
(b) title of a work published as by itself—not inside another work. These two types of titles are formatted
differently, as illustrated below.

The ruse of clarity. Article published in the journal College Composition & Communication
Focus groups as qualitative research (2”d ed.). Book title including edition number
Writing across borders: Students have their say [Video webcast]. Title with form of work bracketed

In the Title Element, include subtitles as shown above. Include volume numbers or report numbers inside
parentheses as shown above. Indicate the form of work (e.g., brochure, motion picture, audio podcast) if the
form varies from ordinary print or electronic print media (see example above).
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ELEMENT 4: THE PUBLISHER ELEMENT (see also APA 6.30). The fourth element, Publisher, varies
according to type of source. Teach yourself the rule patterns below. In these examples, the publisher
information element has been underlined to illustrate the most commonly used types of sources.

A. Books: The publisher information element contains: (a) City, (b) State, and (c) Publisher
name.

Behrens, L., & Rosen, L. J. (2007). A sequence for academic writing (3" ed).

Thousand Oaks, CA: Jossey-Bass.
@ () (c)

B. Periodicals: The publication information element contains: (a) Title of journal, (b) volume number,
(c) issue number (if provided), (d) page number range, and (e) doi number, (if provided).

Lambert, S. (2011). Sustainable leadership and the implication for the general further
education college sector. Journal of Further & Higher Education, 35(1), 131-

148. d0i:10.1080/0309877X.2010.540319 @) ®) ) @
(e)
C. Internet Sources: The publisher information element contains (a) the words “Retrieved from” and (b)
the document’s URL (Internet address)

Alcoholics Anonymous. (1972). A brief guide to Alcoholics Anonymous. Retrieved from
@)

http://www.aa.org/lang/en/catalog.cfm?origpage=18&product=8
()

(Note: Do not place period after a URL or DOI number.)

D. Electronic Databases: The publisher information for an electronic database source is the same as a
for a print source. Do not give either the database name or a URL. However, if the database
provides a DOI number, give that at the end of the reference after the period.

Missing Elements [6.27-6.30]

What happens if one of the four elements is missing? First, try to find the source in a academic database,
where the citation information is likely to be complete. Otherwise, adjust as follows:

1. Author. If the author's name is not provided, move the title into the author’s position (that is, to the
beginning of the reference) and alphabetize the reference by the title (skipping the words The, A, or An
at the beginning of the title). For the in-text citation, use the first word or two of the title followed by the
publication year. (See also APA 6.27.) If you are not sure about the author, consult the SMU Library or
Writing Center.

2. Publication date. If the publication date is missing, use the abbreviation “n.d.” inside parentheses
(without quotation marks) in the place of the date, both in the reference list entry and in the in-text
citation. (See also APA 6.28.)

3. Title. If no title is given (highly unusual), give a one- or two-word description inside brackets where the
titte would normally be: e.g., [Letter to the editor]. (See also APA 6.29.)

4. Publisher Information. If the publisher information given is not sufficient to allow readers to retrieve the
source, then do not use the source. If the source is an unpublished one, give that information after the
title: for example,

Author, X. (Year). Title. Unpublished manuscript.

Remember that missing citation information can weaken your your credibility with readers.

Not all sources will fit neatly into APA guidelines. If you encounter a source like that, use (a) your
knowledge of APA rule patterns and (b) your understanding of the purpose of APA citations—
identification and retrievability—to find a reasonable solution to a citation question.
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REFERENCE PAGE: Format & Arrangement [6.25]

e The reference page begins at the top of a new page following the last page of the body of your paper.
- Do not press the Enter key repeatedly to force a new page. Instead click the Insert Tab and then Page
Break (CTRL+Enter).
- Place the title “References” (without quotation marks) at the top center of the page. Do not boldface
the title.

o After typing the title, but before typing the first entry, set up automatic hanging indents (directions are in
the “Using Microsoft Word for APA” section). Do not attempt to make hanging indents manually, which
will cause your formatting to fall apart when you revise!

e Alphabetize the entries by the last name of the first author listed on the source.
- Note that first names are not used—only intitials, which precede the surnames.
- Ordering the entries when authors’ last names are the same can become complicated. Refer to the
APA manual or call the Writing Center if you have questions
- You can type the entries in any order and alphabetize quickly with the Sort Icon on the Home Tab (see
“Using Microsoft Word for APA” section), provided that you use autmatic hanging indents.

e The reference page is double-spaced throughout. Do not place an extra line between entries.
e References are not numbered or bulleted.

e Remember that the reference page and the in-text citations must match (except for personal
communication and secondary sources).

See the sample reference page at the end of the Reference Page Entries section.

REFERENCE PAGE ENTRIES [pp. 184-224]

The examples in this booklet are set at 1.5 line spacing and reduced font to conserve space, *
but the APA calls for double-spacing and 12 pt. Times New Roman font throughout the text.

The reference list always begins on a new page. It contains an entry for each source cited in the paper, and
only sources cited in the paper, listed in alphabetical order by author’s last name. There are only two
exceptions:

o Personal communication of the writer (such as an interview), which is cited in the text but not in the
reference list because it is not a retrievable source [p. 179];
o Classical works such as the Bible, Qur'an, or ancient works like Aristotle [p. 178].

Entries are double-spaced within entries and between entries. Each entry is formatted in hanging indent
(see instructions in the “MS Word for APA Tasks” section of this booklet).

You will encounter an endless variety of sources and countless variations in types of sources. The only way
to ensure accuracy is to refer frequently to the APA manual [pp. 180-224], where you will find excellent
illustrations of APA style, including a complete reference page.

PRINT SOURCE EXAMPLES

Book
Format:
1 2 3 4
'Author, X. '(Year)'. Title of book. E:ity, State: Publisher Name.I

Example: Cite on Your Reference Page

Lazear, D. G. (1994). Multiple intelligence approaches to assessment: Solving the assessment

conundrum. Tucson, AZ: Zephyr Press.

1. Author. Last name followed by initials only. End the author element with a period
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2. Publication date. Always place the date inside parentheses and end element with a period. In most
cases, the publication date will be a year only—no month or day.

3. Title. Book titles are italicized. Capitalize only the first word, proper nouns, and the first word
following a colon. End the element with a period.

4. Publisher Information. Give the city and state (two-letter US Postal abbreviation) followed by a colon
and the publisher's name. End the citation with a period unless the final element is a URL or doi
number.

Cite in Your Paper: Running text: Lazer (1994) reported . . .
Parenthetical: (Lazear, 1994)

Book, Publisher as Author

American Psychological Association. (1994). Publication manual of the American

Psychological Association (5th ed.). Washington, DC: Author.

1. Author. The author can be an individual or an organization. End the author element with a period.

2. Publication date. Place the year inside parentheses. End the element with a period.

3. Title. If a volume number exists, place it in parentheses after the title. Place a period after the closing
parenthesis.

4. Publisher information. When the author and publisher are the same, use the word Author (no italics)
for the publisher name.

Book, Translated

Example: Cite on Your Reference Page
Freire, P. (2000). Pedagogy of the oppressed (M. F. Ramos, Trans.). New York, NY:
Continuum. (Original work published 1972)

Author. Last name, comma, first initial followed by period.

Publication date. Use the publication date of the translation, not of the original.

Title. If you read a translation of the original work, give the translator's name after the title.
Publisher information. After the publisher name, in parentheses, add the date of the work’s
original publication.

PonpE

Cite in Your Paper: If you know the date of the original work, include both dates in your citation as
follows: Running text: Freire (1972/2000) explained . . .
Parenthetical: (Freire,1972/2000)

Book, Chapter in a book [p.204. See also http://blog.apastyle.org/ under “Chapter in a book”]

Chapter author is author of entire book

If the chapter author is the author of the entire book, cite the entire book. For example,

Fraenkel, J. R., & Wallen, N. E. (2006). How to design and evaluate research in
education (6™ ed.). Boston, MA: McGraw Hill.

For more details on citing chapters when the chapter author and the book author are the same, go
to the official website of APA style at http://blog.apastyle.org/ and search the blog for “chapter in a
book.”

However, if the author of the chapter is different from the author of the book, or if the chapter is in
a book whose editors are named, see “Chapter in an edited book” below.
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Chapter in an edited book
Format:

Author, X. (pub year). Title of chapter. In X. Editorname (Ed.), Title of book (pp.
xxx-xxx). City, State: Publisher name.

Example: Cite on Your Reference Page

Murphy, R. P., & Urquhart, A. T. (2010). Sexuality in the headlines. In K. P. Murphy & J. L.
Pierce (Eds.), Queer Twin Cities (pp. 45-80). Minneapolis, MN: University of
Minnesota Press.

Author. The authors of the chapter are placed at the beginning of the element.

Publication date. For a book, give the year only.

Title. The title element consists of (a) Title of chapter; (b) the word In (not italicized), followed by
editor name and (Ed.); and (c) Title of book. Do not invert the editor’'s names (i.e., initials precede the
surname).

4. Publisher information. City, State: Publisher Name.

wh e

Cite in Your Paper: Running text: Murphy and Urquhart (2010) observed . . .
Parenthetical: (Murphy & Urquhart, 2010)

Periodical Article: Journal

Format:
1 2 3 4

Author, X. EYear)T :I'itle of article.lTitIe of Periodical, volume(issue), page range. doi

number

1. Author. For multiple authors, separate each author with a comma. Use an ampersand (&) before the
last author (or before the second author if there are only two).

2. Publication date. When a volume and issue—or just a volume—atre provided, give only the year for
the publication date. If no publication date is available, type (n.d.).

3. Title. Do not italicize. Capitalize only the first word, the first word after a colon, and proper nouns.

4. Publisher information. Include (a) Title of the Periodical (italicized and capitalized as in the source)
and (b) volume number, issue number, and page range—typed this way: 2(3), 123-134. If a doi
number is provided, add it after the period as shown in the example below.

Example: Cite on Your Reference Page

Chang, A., Chan, F., Gudmundsson, A., & Sawang, S. (2011). Motivating blue-collar
employees: A case study of the chinese workforce. Journal of Asia-Pacific Business,
12(1), 69-85. d0i:10.1080/10599231.2011.537504

1. Author. For multiple authors, separate each author with a comma and include ampersand (&)
between last two authors.

2. Publication date. When a volume and issue—or just a volume—are provided, give only the year for
the publication date. If no publication date is available, type (n.d.).

3. Title. Do not italicize. Capitalize only the first word, first word after a colon, and proper nouns.

4. Publisher information. Include (a) Title of the Periodical (italicized and capitalized as in the source)
and (b) volume number, issue number, and page range—typed this way: 2(3), 123-134. If a doi
number is provided, add it after the period as shown in the example below.

Cite in Your Paper: First Citation
Running text: Chang, Chan, Gudmundsson, and Sawang (2001) explained. . .
Parenthetical: (Chang, Chan, Gudmundsson, & Sawang, 2001)
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Additional Citations
Running text: Chang et al. (2001) concluded . . .
Parenthetical: (Chang et al., 2001)

Periodical Article: Newspaper

Format:
1 2 3 4

r 1T 1 L 1
Author, X. (Year, month, day). 'Il'itle of article'. Title of Periodical, page number.

1. Author. If no author is given, move the article title to the author position, retaining the formatting
of the title. Place a period after the title.

2. Publication date. Because newpapers usually don’t have volume and issue numbers, give the
full date: year, month, day—typed like this: (2011, May 18). If a volume and issue number—or
just the volume—are given, use only the year for the publication date.

3. Title. Do not italicize. Capitalize only the first word, first word after a colon, and proper nouns.

4. Publisher information. Give the Title of the Periodical (italicized and capitalized as in the source).
If a volume and issue are provided, type them like this: 2(3). Give all page numbers, including
section letter, on which the article appears, like this: B3, B9. If a doi number is provided, add
it after the period as shown in the example below.

Example: Cite on Your Reference Page
Belson, K. (2011, March 31). Sour economy and multiple new crises test Japan’s young.
The New York Times, Al, A3.

Cite in Your Paper: Running text: Belson (2011) reported . . .
Parenthetical: (Belson, 2011)

Periodical Article: Newspaper Editorial

When the author is not identified, move the title to the author position:

Example: Cite on Your Reference List

Without the campaign donors, this wouldn’t be possible [Editorial]. (2011, March 31).
The New York Times, A26.

1. Author. With no author is identified, place the title in the author position. In brackets identify the
article as an editorial. End with a period

2. Publication date. If no volume and issue numbers exist, give the full date, e.g., (2011, May 6).

Title. Leave blank

Publisher information. Give the title of the newspaper in italics. Follow the newspaper example

for capitalization of title. Give all pages (including section) on which article appears.

Pw

Cite in Your Paper: (“Without the campaign,” 2011).
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ELECTRONIC SOURCES [6.31-6.32, 7.01-7.02]

These fall into two general categories: (a) Documents from the Web (Internet) and (b) documents
from restricted access electronic databases (such as those available through the Saint Mary’s
University library).You must distinguish between the two.

Document from a Web Site

Format:
1 2 3 4

Author, X. (Year). Title of article. Retrieved from http://Www.XXXXXX.XXX

1. Author. If no author is given, place the title in the author position. Note that the author may be an
organization instead of an individual.

2. Publication date. Give the year. If no volume or issue number exists, then give the month and day
as well: e.g. (2011, June 11). If no date is provided, type (n.d.).

3. Title. You can usually treat the title as a “stand-alone” document like a book title: Italicize and
capitalize only the first word, the first word after a colon, and proper nouns. If the work is clearly
part of a larger work, format the title as you would a journal article or chapter in a book.

4. Publisher information. Type the phrase “Retrieved from” (no quotation marks), followed by the
Uniform Resource Locator (URL—also called an Internet address). Give the retrieval date only for
an "unstable" source—one you think likely to be removed soon.

Example: Cite on Your Reference Page
Zaharim, A. (2008). 4 gap study between employers’ perception and expectation of
engineering graduates in Malaysia. Retrieved from http://www.wseas.us/e-

library/conferences/2008/crete/education/education64.pdf

NOTE: Do not hyphenate a URL to force a break at the end of a line. It is not necessary to break a
URL to avoid white space. Do not use a period to close an entry ending with a URL.

Cite in Your Paper: Running text: Zaharim (2008) discovered . ..
Parenthetical: (Zaharim, 2008)

Journal Article from a Web Site [p. 200, #8]

Format:
1 2 3 4

Author, X. (Year). Title of article. Title of Periodical, volume(issue), page range.

Retrieved from http://Www.XXXXXX. XXX

1. Author. If no author is given, place the title in the author position in reference. Note that the author
may be an organization instead of an individual.

2. Publication date. Give the year. If no volume or issue number exists, then give the month and day
as well: e.g. (2011, June 11). If no date is provided, type “(n.d.)” without quotation marks.

3. Title. The title of the article should not be italicized. Capitalize only the first word, first word after a
colon, and proper nouns.

4. Publisher information. Include (a) Title of the Periodical (italicized and capitalized as in the source)
and (b) volume number, issue number, and page range—typed this way: 2(3), 123-134. If no doi
is provided, type the phrase “Retrieved from” (no quotation marks), followed by the URL. If a doi
number is given, use that it place of “Retrieved from +URL.”

Example: Cite on Your Reference Page
Mollica, R. F., Wyshak, G, & Lavelle, J. (1987). The psychosocial impact of war trauma

and torture on Southeast Asian refugees. The American Journal of Psychology,
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144(12), 1267-1572. Retrieved from
http://ajp.psychiatryonline.org/cgi/reprint/144/12/1567

Cite in Your Paper: First Citation
Running text: Mollica, Wyshak, and Lavelle (1987) proposed . . .
Parenthetical: (Mollica, Wyshak, &Lavelle, 1987)

Additional Citations
Running text: Mollica et al. (1987) advocated . . .
Parenthetical: (Mollica et al., 1987)

ERIC Database
ERIC Online Resources [p. 212, #62]

ERIC (Educational Resources Information Center) contains mostly citations and abstracts, not full
text documents. If you want the full document, you can order it from ERIC or use the location
information to retrieve it yourself (with help from a librarian).

Format:
1 2 3 4

Author, X. (Year). Title of article. Retrieved from ERIC database. (EDxxxxx)

1. Author. If no author given, place title in author position in reference. Note that the author may
be an organization instead of an individual.
2. Publication date. Give the year. If no volume or issue number exists, then give the month and
day as well: e.g. (2011, June 11). If no date is provided, type “(n.d.)” without quotation marks.
3. Title. The may be either a stand-alone document or an article in a journal. Format accordingly.
4. Publisher information. Type the phrase “Retrieved from” (no quotation marks), followed by
the phrase “ERIC database” (no quotation marks). After a period, type the ED or EJ
number in parentheses as shown in the examples.

Example: Cite on Your Reference Page

Miller, D. C., Sen, A., Malley, L. B., & Burns, S. D. (2009). Comparative indicators of
education in the United States and other G-8 countries: 2009. Retrieved from
ERIC database. (ED504634)

NOTE: If you cannot retrieve the full text document from ERIC and instead order it through a
librarian or other provider, cite it like any other source of its type, without mention of ERIC
(because you found the citation in ERIC but actually retrieved the document elsewhere.).

Cite in Your Paper: First Citation
Running text: Miller, Sen, Malley, & Burns (2009)) posited . . .
Parenthetical: (Miller, Sen, Malley, & Burns, 2009)

Additional Citations
Running text: Miller et al. (2009) predicted . . .
Parenthetical: (Miller et al., 2009)
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Electronic Database (Restricted Access): Journal Article

Access to most academic databases is restricted to subscribers. As a student, you have access to many
of them because the Saint Mary’s University library subscribes to them. Examples include ProQuest
Education Journals and the databases within EBSCO Megafile. Sources retrieved from most of these
sources do not use a database name or URL when cited.

Format:
1 2 3 4

Author, X. EYear)T :I'itle of article..TitIe of Periodical, volume(issue), page range. doi

number

1. Author. For multiple authors, separate names with a comma. Use an ampersand (&) before the
last author (or before the second author if there are only two).

2. Publication date. If no publication date is available, type (n.d.). Do not give month and day if the

volume and issue are provided.

Title. Do not italicize. Capitalize only the first word, the first word after a colon, and proper nouns.

Publisher information. Include (a) Title of the Periodical (italicized and capitalized as in the source)

and (b) volume number, issue number, and page range—typed this way: 2(3), 123-134. If a doi

number is provided, add it after the period as shown in the example below.

sw

NOTE: Articles from electronic databases are generally treated like print sources.Contrary to APA
guidelines, Saint Mary’s University does not require students to provide a publisher home page URL if
a doi number is not provided. If no doi number is provided, you may simply end the reference entry
after the page range.

Example: Cite on Your Reference Page
Weissberg, R. (2007). Oh to be rid of administrative wimps! Academic Questions, 20(2),
146-149. doi: 10.1007/s12129-007-9006-x

NOTE: If no doi number is available, end the citation with the period after the page range. (The APA
says to give the home page of the journal, but Saint Mary’s University does not require that information
from students.)

Cite in Your Paper: Running text: Weissberg (2008) theorized . . .
Parenthetical: (Weissberg, 2008)

MORE REFERENCE ENTRY EXAMPLES

Business and Management Online References.

Business and financial reports from online databases often differ significantly from other kinds of
electronic sources. Because the reports are updated frequently, the retrieval date is usually a necessary
part of the reference. Sometimes the database name is required to help the reader locate the
information. A few examples are provided here. More information is available at the Writing Center's
Web site: www.smumn.edu/tcwrite

« Gale Virtual Reference Library

Use the citation information provided by Gale, but format that information as closely as possible to
APA style as shown below. Retain Gale as part of the publisher information.

Example: Cite on Your Reference Page
Lane, M., Salter, S., & Teague, K. (2007). United Airlines Corp. In Encyclopedia of

major marketing campaigns (Vol. 2, pp. 1695-1704). Retrieved from Gale

Virtual Reference Library.
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Cite in Your Paper: First Citation
Running text: According to Lange, Salter, and Teague (2007) . . .
Parenthetical: (Lange, Salter, & Teague ,2007)

Additional Citations
Running text: According to Lange et al. (2007) . . .
Parenthetical: (Lange et al., 2007)

« EDGAR Database of Online Corporate Financial Information

EDGAR is a public electronic database of forms filed with the U.S. Securities and Exchange
Commission. The source of the information is provided by the companies that file the forms.

Example:
Best Buy. (2009, June 29). 11-K. Available from EDGAR Company Search:
http://www.sec.gov/edgar/searchedgar/companysearch.html

o The title of the document is the form number
e The URL takes readers to the EDGAR company search page, hence "available from."

« Cite in Your Paper: Best Buy (2009) claimed . .. or ... (Best Buy, 2009)

« Datamonitor Online

Datamonitor is accessed through Business Source Premier database. Datamonitor is the author of
its own reports.

Example:

Datamonitor. (2009, May). Health care equipment & supplies in the United States: Industry

profile (Reference code 0072-2077). Available from http://www.datamontor.com

« Cite in Your Paper: Datamonitor (2009) reported . . . or ... (Datamonitor, 2009)

Audiovisual Materials

Name the form of the work in brackets after the title.
« Motion Picture
Example:
Anderson, W. (Producer), & Baumbach, D. (2005). The squid and the whale [Motion
picture]. U.S.: Samuel Goldwyn Films.

« Cite in Your Paper: Anderson and Baumbach (2005) imagined ... or... (Anderson &
Baumbach, 2005)

« Video (DVD)

Example:
Haynes, H. (Producer), & Torres, A. P. (Director). (2004). National Geographic—Wetback:
The undocumented documentary [DVD]. U.S.: National Geographic.

« Cite in Your Paper: Haynes and Torres (2004) ... or ... (Haynes &Torres, 2004)
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« Map (retrieved from a website)

Example:

Central Intelligence Agency. (Cartographer). (2009, July 2). South Asia: Pakistan

[Topographic map]. Retrieved from https://www.cia.gov/library/publications/the-

« Cite in Your Paper: Central Intelligence Agency (2009) ... or... (Central Intelligence
Agency, 2009)

If the map is reproduced in your text as a figure, follow directions under "Tables and Figures" in this
booklet. Place the reference information after the caption under the figure. If the source is not cited
elsewhere in the paper, you do not have to place an entry on the reference page.

Blogs

Web blogs (Web blog posts) can be useful sources if you establish the credibility of the blog publisher.
Be careful about using information from a blog responder unless you have checked the reliability of the
information. It if is reliable, it probably exists elsewhere in a form that is more permanent and more
easily verified than the information in a Web blog or a reponse to a Web blog.

Author, X. (Year, Month day). Title of blog [Web log post]. Retrieved from http://XXxxxx

1. Author. If only a screen name is given (as the in blog comment below) use that
2. Publication date. As shown

3.Title. If the title is one of a series in an ongoing blog, format the title as you would a journal article
title.

Example:
Fogarty, M. (2010, June 24). Comma splice [Web log post]. Retrieved from

http://grammar.quickanddirtytips.com/comma-splice.aspx

The title is not italicized because it is part of a larger blog series call Grammar Girl.

« Cite in Your Paper: Fogarty, M. (2010) ... or... (Fogarty, 2010)

e Blog Comment
Example:

FIaEMT. (2012, May 26). [Web log comment]. Retrieved from
http://grammar.quickanddirtytips.com/comma-splice.aspx

The example illustrates a comment to the blog in the previous example (Fogarty, M.) The author of
the comment provided only a screen name, not a real name. The author did not give the comment a
title, so all you can give in the reference is the description of the source form in brackets.

o Cite in Your Paper: FIaEMT (2010) ... or... (FIaEMT, 2010)

You can see from the citation information that readers will not give much credence to a blog response
because the author cannot even be identified, let alone verified.
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Legal Documents

Reference entries for legal documents are explained in the appendix to Chapter 7, pp. 216-224, of
the APA manual. Library staff can provide assistance in locating reliable legal references. Writing Center
staff can help you cite the references in APA style.

URLs (UNIVERSAL RESOURCE LOCATORS—INTERNET ADDRESSES)

22

Knowing how to understand a URL will tell you much about the document you find on a web site. The
example below is the URL for a document posted on the National School Board Association web site.

Components of a URL
1 2 3 4

' http;:/'/WWW.nsba.oré/s'bot/tooIkit'/IIDand LDev.html

Components are separated by a “forward slash”: /

1. Protocol indicates the means by which the web browser communicates with the file server.

2. Domain (Host) Name is vital information for you because it tells you who published the document on
the web.

3. Path to document. The path consists of one or more units that link your document to the web site’s
home page (domain). Without all the path links, your document cannot be found from the web site’s
home page.

4. Document name identifies the specific document you plan to cite.

URL Domain Name

The domain name helps you determine to what extent the information may be objective or biased and
helps you determine how best to use the information in your paper. The domain name “extension” (the
three letters after the dot in a domain name) tells you what kind of web site posted your document.
Here are the most common ones:

.biz = small business .gov = government
.com = commerce .net = electronic communication
.edu = education .org = organization, usually non-profit

(For more information on extensions, see http://idcwebs.com/Understanding_Web_Extensions.htm)

How the URL Can Help You Identify Source Credibility

If you cannot determine the author or publisher of an online document, copy only the domain name
portion of the URL (for example, www.nsba.org) and paste it into your browser to take you to that home
page. From there, you can read about the website owner and ask yourself about its mission, self-
interest, and possible biases. Look for links that say “About Us,” “Who We Are,” “Mission,” or
something similar that will give you the identifying information you seek.

Suppose you were seeking information about the safety of nuclear power plants, and you located two
documents on the web . Suppose these two documents provide opposite points of view on nuclear
energy safety. What should you do? How can you present the opposing information to your readers

and lead them to well-informed conclusions?
—_—

Suppose the first document was retrieved from http://www.nei.org/keyissues/safetyandsecurity
[plantsecurity/ and had very reassuring things to say about safety at nuclear power plants.

1
Say the second document was retrieved from http://www.nirs.org/factsheets/llwnolowrisk.pdf
and presented a terrifying scenario of likely nuclear disaster.

Which is the more credible source? By tracking the URLs’ domain names, you identify the two
organizations and their mission statements as follows

www.nei.org = Nuclear Energy Institute (NEI) is" the policy organization of the nuclear energy
and technologies industry and participates in both the national and global policy-making process.
NEI's objective is to ensure the formation of policies that promote the beneficial uses of nuclear
energy and technologies in the United States and around the world."
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www.mirs.org = Nuclear Information and Resource Service (NIRS). "We were founded to be
the national information and networking center for citizens and environmental activists concerned
about nuclear power, radioactive waste, radiation and sustainable energy issues. We initiate large-
scale organizing and public education campaigns on specific issues, such as preventing
construction of new reactors, radioactive waste transportation, deregulation of radioactive
materials, and more. "

What to do with this information:

In the example above, you have conflicting information from two sources with opposing missions. What
can you do with the information? You can use it in your paper, but you should present the information
as points of view from organizations with vested interests or biases. You can then look for other,
unbiased sources with objective information that supports one or other of those points of view. You
must constantly check you sources for bias—either intentional or not—and let your readers know if bias
might exist. You remain objective yourself while presenting your readers with multiple aspects of a
disputed issue. You then draw your own conclusions based on an understanding of your sources.

DOI NUMBERS: What is a DOl number? [6.31-6.32, 7.01]

DOI is an abbreviation for Digital Object Identifier, a unique set of characters assigned to identify
an intellectual property resource so that it is searchable on the Internet. DOI numbers always begin
with 10, followed by a decimal. They can contain letters and symbols as well as numbers.

To use a DOI to locate a source on the Internet, go to your Web browser and type the following on the
address line: dx.doi.org

When the DOI page opens, type or copy the doi number in the slot, and press Go. (See illustration below.)

S 12 A |§, http://dx.doi.org/ <" GO TO THE DOI HOME PAGE: dx.doi.org ‘
. — —
Glyed The DOI”System
™

T

Resolve A DOI Name

> ENTER THE DOl NUMBER doi: |1[J_ 1080/15411790903158746

>CLICKTD LOCATE SOURCE

Most, but not all, databases now assign DOI numbers to sources. In some databases, the DOI appears in
the short citation; in others, you must click on the source title to obtain the DOI. (See Writing APA
References for Electronic Sources under "APA Resources" on the Writing Center Web page, or ask a
librarian, or open a citation tutorial.)

In newer sources the DOI nhumber appears with a prefix: hppt://dx.doi.org. So the number may look like this
http://dx.doi.org/10.1037/a0030944 instead of this 10.1037/a0030944

For your reference page, type it either way
doi: 10.1037/a0030944 or http://dx.doi.org/10.1037/a0030944

but use a consistent style throughout your paper.
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SAMPLE REFERENCE PAGE
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Did not find the answer to your citation question in this booklet?
Visit the APA Style Blog at http://blog.apastyle.org
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CITING SOURCES IN YOUR PAPER [174-179. See table p. 177]

Purpose of Citing in Your Paper
The purpose of the in-text citation is to lead readers to the correct alphabetized entry on the Reference
page. The samples that follow illustrate variations on the same in-text citation.

Frazier and Paulson (2006) found that the portfolio method of assessment motivated reluctant

WIIters. The word and must be spelled out in running text, but the

ampersand (&) is used inside parentheses.
The portfolio method of assessment can also motivate reluctant writers (Frazier & Paulson,
2006).

In a 2006 study, Fazier and Paulson observed that the portfolio method of assessment motivated
reluctant writers.

Relationship to Reference Page Entries

Remember that there are 4 elements in a reference page entry: (1) Author, (2) Publication date, (3) Title, (4)
Publisher information. The first two elements of the reference list entry—the author and publication
date--make up the in-text citation (but do not include the author's initials).

So if the first elements of an entry are Lazear, D. G. (1994), then the in-text citation would be
Lazear (1994) ... or (Lazear, 1994).

The in-text citation must match the author (minus initials) and date of its reference page entry so
that readers can locate the entry.

Multiple Authors

e If a source has only one or two authors, name the authors and publication date each time the
source is cited.

e |f a source has 3 to 5 authors, name all the authors in the first in-text citation; but in all other in-text
citations, give only the name of the first author, followed by et al. (no italics) and the publication
date..

For example, a reference list entry like this . . .

Giometti, M., Whitehead, M, Regas, D. & Shipley W. (2001).
would be cited in the text the first time this way:

Giometti, Whitehead, Regas, and Shipley (2001) concluded that . . .
and thereafter would be cited this way:

Giometti et al. (2001) concluded that. . .

e If a source has 6 or more authors, name only the first author, followed by et al., in all in-text
citations, even the first citation.

For example, a reference list entry like this . . .

Gafin, Y, Hall, K, Monski, E, Gold, H, Lin, L., Getz, S, & Froman, Z. (2009)
would be cited each time like this:

Gafinetal. (2009) said ... -or- ... (Gafinetal., 2009)

Where and When to Cite?

Two frequent APA questions are, how often should | cite and where should | cite (meaning beginning,
middle, or end of sentence or paragraph—and inside or outside parentheses)? These are difficult questions
and can be answered only by understanding how you are using your sources in the paper.
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Citations Illustrated

The following paragraphs illustrate two styles of in-text source citation. In which paragraph is the
main idea easier to follow?

List multiple sources in order of
appearance on reference page.

1. The following paragraph is adapted from Serovich, 2000:
For people who are diagnosed wi issue inevitably to be addressed
a, Melts, Petronio, and Margulis, (1993);

Greenberg and Stone (1992); and Pennebaker and Beall (1986) documented that some people

is whether to share this-information with others. D

disclose information when they feel distressed and obtain some benefit by doing so. For instance,

according to Pennebaker, Coler, and Sharp (1990), those who disclose freely visit physicians less

frequently, demonstrate unimpaired immune function,\and exhibit autonomic nervous system
regularities to greater degrees than their nondisclosing counterparts. According to Greenberg and
Stone (1992), researchers have also demonstrated that suppressing thoughts or communication

about burdensome experiences can increase the likelihood of stress-related difficulties. Given

these findings, the relationship between disclosure and r| Use the word and outside parentheses
Use an ampersand (&) inside parentheses.

therapists and for researchers to explore.

2. The following is the paragraph as written by Serovich, 2000*:

For people who are diagnosed with a chronic illness, one issue\inevitably to be addressed
is whether to share this information with others. Researchers have documented that some people
disclose information when they feel distressed and obtain some benefit by 'doing so (Derlega,
Melts, Petronio, & Margulis, 1993; Greenberg & Stone, 1992; Pennebaker & Beall, 1986). For
instance, those who disclose freely visit physicians less frequently, demonstrate unimpaired
immune function, and exhibit autonomicervous system regularities to greater degrees than their

nondisclosing counterparts (Pennebaker, Colder, & Sharp, 1990). Researchers have also

demonstrated that suppressing thoughts or commuinication about burdensome experiences can
enberg & Stone, 1992). Given these

alth is important for both therapists

increase the likelihood of stress-related difficulties (

findings, the relationship between disclosure and mental

and researchers to explore. If additional sources support your point, cite them all in the same parentheses,
separated by semicolons.

Source:  Serovich, J. M. (2000). Helping HIV-positive persons to negotiate the disclosure process to partners, family
members, and friends. Journal of Marital and Family Therapy, 26(3), 365-372.
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Running Text or Parenthetical Citations?

To cite in running text means to place the author’'s name in the sentence without parentheses, as
illustrated in the first paragraph above. (Always place date and page number in parentheses.)

To cite parenthetically means to place the author's name inside parentheses along with the date (and
page number, if used), as illustrated in the second paragraph above.

Is one of the two styles better than the other? It depends. The guidelines below may help you decide.

Discourse About Ideas

A literature review, for example, is organized by themes. Instead of separately summarizing each article
you read, you should write about themes that emerged from your review of the literature. For instance, you
might write something like this:

Transformational leaders are recognized as those who inspire their followers to higher levels
of performance and change.

In that sentence you are writing in your own voice, stating an assertion for which you found support in the
literature. You need to cite each source you read that supported that assertion. A good place to cite in a
case like this is at the end of the sentence in parentheses, like this :

Transformational leaders are recognized as those who inspire their followers to higher levels
of performance and change (Bass & Avolio, 1993; Burns, 1978; Yukl, 1994) .

Placed in parentheses at the end of a sentence, citations are less distracting to the flow of ideas.

Discourse About Works

If, on the other hand, you find that the entire paragraph contains ideas from the same author (in other
words, you would be citing the same author at the end of each sentence), then you probably need to
introduce the author's name into the running text, where it is more noticeable, because you are now
discussing the author or the author's work, not just citing the author as support for your own assertion.
Note the following example:

Pounder ( 2009) assumed that a university classroom could be considered analogous to an
organization, with the professor as a leader and students as followers. Pounder concluded
that a transformational teaching style leads to positive student learning outcomes. Students
with transformational teachers are motivated to work harder.

Source: Pounder, J. S. (2009). Transformational classroom leadership: A basis for academic staff
development. Journal of Management Development, 28(4), 317-325. doi:
10.1108/02621710910947353

Whichever way you cite, parenthetically or in running text, you must at all times make clear to readers
the sources of all your information. Frequent citations are a necessity and are expected in academic
papers.
Vary the Citation Wording
1. Stieglitz and Hernandez (2002) emphasized that . . . .

2. Three earlier studies (Gudmund, Farrar, & McDermot, 2004; Willum, 2000; Wright &
Formani, 2006) were inconclusive . . . .

According to Khali and Kozumi (2000), earlier research failed to . . . .

3
4. Zarweit (2007) responded, “At no time were the subjects informed” (p. 92).
5. Czel (1999) defined sensation seeking as behavior that . . . .

6

... but the results were inconclusive (Hammel, 2003).
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Avoid anthropomorphism (attributing human actions to non-humans nouns):

Not: A survey by Biggs and McCoy (2001) reported . . .

But: Biggs and McCoy (2001) reported ... [Surveys, research, studies, and reports don't do
anything. Their authors do. ]

Must | use page or paragraph numbers for Internet Quotations?

The APA says yes ( see section 6.05 in the manual) and offers suggestions for identifying unpaginated
text by using paragraph numbers or section titles.

How do | cite a personal interview? [6.20]

n A personal interview is not a retrievable source, so it does not get an entry on the Reference page.
However, it must be cited in the text as follows: (J. J. Doe, personal communication, April 10,

2012). If the name of the person being cited is written into the running text, then it need not appear
again in the parentheses.

NOTES
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TITLES: Formatting [2.01, 4.07, 4.15, 6.29]

Titles follow special formatting rules when they appear on an APA reference page. Readers familiar with
APA can understand the nature of the sources by noting the way its title is formatting. At first glance the
rules appear confusing, but actually they boil down to a simple pattern. Remember that all titles fall into one
of three categories. Just identify the category and the follow the typing rules in the box below.

A. TITLES ON YOUR REFERENCE PAGE [6.29]

Three Types of Titles and Their Formatting Think of all titles as falling into three categories:

Type 1. Work published inside a larger work (e.g., chapter in book, article from journal).
—>Do not italicize. Capitalize only the following: (a) first word, (b) first word after a colon,
(c) proper nouns, (d) abbreviations.

Type 2. Work published alone (e.g., book, stand-alone Internet document, brochure, report,
dissertation).
—ltalicize. Capitalize only the following: (a) first word, (b) first word after a colon, (c)
proper nouns, (d) abbreviations.

Type 3. Periodical (journal , newspaper, or other periodical)
—ltalicize. For capitalization, follow the form used by the publisher.

Examples

v Type 1 vV Type 3

Predicting alcoholism: College binge drinking. National Journal of Addiction, 12(3), 2-8.
v Type 2 v

Elgin, G. (2003). The politics of curriculum in American education. Boston, MA: Boynton.

B. TITLES USED IN YOUR PAPER

Normally, titles of works cited do not appear in the text of your paper. However, if you do use a
published title in your paper, follow these formatting rules:

Type 1. Place inside quotation marks. Capitalize major words (see below).
Example: "The American Work Ethic" (article from New Psychology)
Type 2. ltalicize. Capitalize major words.
Example: How to Design and Evaluate Research in Education
Type 3. ltalicize. Capitalize major words (or follow capitalization of publisher).

Examples: (a) New England Journal of Medicine, (b) COMbusiness

Note: When the first word or two of a title is used to replace a missing author in a text citation, follow the
formatting for in-text titles.
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C. MORE ON CAPITALIZING WORDS IN TITLES

The general rule for capitalizing words in titles used in your text is capitalize major words. But what
are major words? Major words are all words except (a) coordinating conjunctions, (b) articles, and (c)
short prepositions. However, capitalize these words as well if they appear as the first word in the title:

The Logic and Rhetoric of Exposition (book)

a. Coordinating Conjunctions (not capitalized)

Coordinating conjunctions are defined as those words that connect grammatically equal elements.
There are seven coordinating conjunctions, and they can be arranged by their first letters to form
the "word" fanboy:

for, and, nor, but, or, yet
Examples: Forgiven but Not Forgotten
"The Cambridge Spelling Report: Help or Hoax?"
The Logic and Rhetoric of Exposition

b. Articles (not capitalized)

Articles are those three critical little words--a, an, and the--without which we can scarcely write a
sentence

c. Short Prepositions (not capitalized)

Prepositions, like articles, are function words. When paired with nouns, they identify relationships
of position and time, like before sundown, between you and me, among the trees, and above
average. There are more than 70 common prepositions. Do not capitalize prepositions of three
words or fewer. There are 13 you should not capitalize:

as at by for in of off on out to up

NOTES
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PUNCTUATION [pp. 87-96]

See also "Transitions and Conjunctions”

A. Spacing [4.01]

Each mark of punctuation is followed by one space. (Two spaces may follow a period ending a sentence;
however, if used the practice should be consistent throughout the paper.)

Exceptions No space is required after
e an opening parenthesis:

Departing flights (except those already noted) are temporarily grounded.
e an opening quotation mark, and comma or period before a closing quotation mark

The captain remarked, “%he space is inadequate.” I agreed.
All other punctuation marks are followed by one space.

B. Apostrophe ()
Use an apostrophe
1. to show ownership or possession.
Add an apostrophe and an s ('s) to words that don't end with an s: for example,
somebody's car (the car belonging to somebody)
the men's locker room (the locker room of the men)
a month's rent (the rent of a month)
Add only an apostrophe after the s to words that already end in s.

twelve days' pay (that is, the pay for twelve days)
the students' tests (that is, tests belonging to the students)

2. to form contractions (e.g., could not = couldn't, he is = he's) ; but do not use contractions in
academic papers.

C. Colon (3)

1. Use a colon after a complete sentence that introduces a list.

The breakfast menu contained the clients’ favorite foods: bran muffins, bananas, pancakes
and maple syrup, and bacon and eggs.

If the introduction is not a complete sentence, no punctu&ntion is needed after it:

Dieters preferred low fat breakfast foods such as strawberries, unbuttered whole wheat
toast, unsweetened cereal, and applesauce.

2. Use a colon on the reference list, to separate publisher location from name.

Hebring, R. J., Jr. & Vang, C. (2008). Collective wisdom, diverse experience: Managers’
real stories (3rd ed.). New York: Random House

D. Commas: Six Rules
The following six comma rules will enable you to punctuate most sentences correctly.

1. Use acomma before a coordinating conjunction (and, but, or, so*, yet, nor, for) if it joins two
sentences. * (when so means therefore or as a result, but not when it means so that)

« Ellen thought the movie was exciting, and Fred liked it more than any he had seen that
year.

« Fred and Ellen saw a movie and went out to dinner afterwards. (No comma needed because
and is not joining two sentences.
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2. Use a comma after introductory expressions.

An introductory expression is a word or words that lead up to the main part of the sentence.

« Frankly, I have had enough of this cold and rainy weather.
« When our bakery closed down, Jan had to make her own bread.
« Confused by the freeway signs, Ralph got hopelessly lost in Chicago.

3. Use commas to separate three or more items in a series.

Use a comma after each item, including the one before the conjunction (and or or).

« Protestors wore black pants, red shirts, and green sashes.
« Students can study before class, after school, or on Saturday afternoon.

4. Use commas to set off words and phrases that interrupt the sentence if those words are not
essential to the purpose of the sentence.

« Michelle took her seat at the table and, much to everyone's surprise, blew her nose on the
tablecloth.

« | liked Brad's sense of humor. His lewd jokes, however, deeply embarrassed his
grandmother.

« Bill, a man of much courage, grabbed the burglar's hand and bit off his trigger finger.

Use a comma to set off a phrase at the end of a sentence if that phrase refers to the entire
sentence that precedes it. These phrases will usually begin with a word ending in —ed or —ing.

Example 1:

The company recognized every branch manager, [raising morale and encouraging high
standards]. \

In the sentence above, the bracketed phrase refers to the entire sentence (underlined) that that
precedes it. Therefore the phrase is set apart from the sentence by a comma. (The relationship
between the sentence and the phrase is one of cause and effect).

The company recognized every branch manager [raising morale and encouraging high
standards]. \ 4

In the sentence above, the bracketed phrase refers only to the underlined phrase, not the entire
sentence. Furthermore, because the underlined phrase is necessary to identify which branch managers
got recognized (only those raising morale and encouraging high standards), the phrase should not be
set off with a comma. If a comma were added, the sentence would change to mean that all branch
managers were recognized and that the recognition raised morale and encouraged high standards (as
in the sentence in the previous example).,

Example 2:

Teachers offered rewarels to the students,/Ltrying to improve test scores].

With a comma, the sentence means that teachers offered rewards in an attempt to improve test scores.
The bracketed phrase refers to the entire sentence (underlined) that precedes it. Therefore, the phrase
is set apart from the sentence by a comma. (The phrase trying to improve test scores might be better
placed at the beginning of the sentence and set apart by a commas.)

Teachers offered rewards to_the students [trying to improve their test scores].

Without a comma, the sentence means that teachers offered rewards only to students who were trying
to improve their test scores. (The phrase is necessary to identify of which were offered rewards;
therefore, the phrase should not be set apart by a comma.
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Example 3:

Close communication exists among the cell types, [allowing interchange of secretions
between the hormones]. \ A

In the sentence above, the bracketed phrase refers to the entire underlined sentence, not just to "cell
types." (The relationship between sentence and phrase is one of cause and effect). the sentence
above means that the interchange results from the close communication that among the cell types.
Allowing refers to the entire phrase close communication exists among cell types

Close communication exists among the cell types [allowing interchange of secretions
between the hormones].

Without the comma, sentence above means that communication exists only among cell types that allow
the interchange. The phrase in brackets refers only to cell types, not to the entire underlined sentence.
Furthermore, the phrase is necessary to identify which cell types allow the interchange; therefore, the
phrase should not be set apart with a comma.

6. If rules 1-5 don’t apply, you probably don’t need a comma. Most people over-use commas.

Exception. Occasionally, a comma is needed to prevent the misreading of a sentence, even if one of the
five rules doesn’t apply. Note the following example:

Patients who can discuss side effects with their doctors before undergoing surgery.

Adding a comma will prevent misreading of the sentence: Patients who can, discuss side effects with
their doctors before undergoing surgery.

E. Dash (—)

Dashes are intended to separate words and phrases. To create a dash, type two hyphens with no space
before, after, or between them. Use dashes to indicate an interruption (e.g., Students in Group 2—
those who received no training—were least successful at accomplishing the task.)

F. Hyphen (-) See also APA [3.11]
Hyphens are used to connect words and parts of words. The hyphen key is located next to the 0 on the
keyboard. Type hyphens with no space before or after (for example, a rags-to-riches story).

G. Parentheses ()

In academic and professional writing, parentheses are used (a) to enclose citation material, and (b) to
enclose letters used for lists, as in this sentence. They are also used (but sparingly) to enclose words or
phrases that are not essential, as illustrated in this sentence..

H. Quotation Marks (" ")

In academic writing, quotation marks are used primarily to enclose direct, word-for-word passages
borrowed from another source.

Commas and periods that finish quotes are always placed inside quotation marks.

Other marks of punctuation are placed outside quotation marks unless they are part of the quoted
material.

Uses of quotations and use of capitals in quotations are topics dealt with elsewhere in this booklet.

I. Semicolon (;)
Use a semicolon

a. between two sentences when a period is not desired:

Sales of buttons and tee shirts were higher than expected; few people bought flags,
however.

b. to separate elements in a series if the elements themse\lﬁes contain commas.

Commission membership included Janet Dubois, mayor; Arun Ramish, city attorney; Tyreesha
Tomlin, school board president; and Harold Rosen, state representative.
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HEADINGS [3.03]

Placing headings in your paper is important for several reasons:

e They help readers follow the organization of your paper.
e They keep you, the writer, focused and organized.
e They provide transition from one section to the next.

Applying the Five Levels

APA follows a fairly simple heading style. There are five levels, but most students usually use only two or
three, and occasionally four levels for a capstone paper. The 5" level is reserved for doctoral dissertations.
After typing your title on the first page of the paper (centered, without boldface or italics),

e  Start with level 1 headings for major subdivisions of the paper (and for reference page heading,
abstract heading, table of contents heading, appendix headings)

Use level 2 headings to subdivide level 1 sections.

Use level 3 headings to subdivide level 2 sections

Use level 4 headings to subdivide level 3 sections

Use level 5 headings (if you are a doctoral student preparing a dissertation) to subdivide a level 4
sections.

e Levell Center and boldface; capitalize major words.

e Level2 Place at left margin and boldface; capitalize major words.

e Level 3 Indent one tab space and boldface; capitalize only first word and proper nouns; place a
period at the end. Turn off bolface and begin paragraph text after the period.

e Level4 Same as level 3 but add italics (keep boldface).

e Level 5 Same as level 4 but remove boldface (keep italics).

» Heading levels 1, 2, 3, and 4 are boldfaced.
» Heading levels 3, 4, and 5 are indented (on same line as text).
» Heading levels 4 and 5 are italicized (but 5 is not boldfaced).

NOTE: The title of the paper is not considered one of the 5 levels. Type the title on the first page of the
paper by centering it, without boldface or italics, and capitalizing the first letter of major words (see
"Capitalizing Titles in Your Text" in this booklet or see APA Section 4.15).

Wording of Headings
e Headings should not be complete sentences or questions:

o Not Cognitive Therapy Is Effective for Treating Depression
o But Cognitive Therapy for Depression

o Not What Are the Characteristics of Transformational Leaders?
o But Characteristics of Transformational Leaders

e Headings should not contain abbreviations.

Look at the examples on the following pages to get an idea how APA headings should look.
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Samples of Headings

Paper with One Level of Heading

is not considered one of the 5 heading levels

Title of Paper

First Level One Heading

APA HEADINGS

-~

[Title appears on first page and title page. Title ]

The text begins here. You can have as many paragraphs as you like under this heading. If
vou are dividing the paper into sections, vou know you will need at least one more heading at
this level because you cannot divide your paper into “one.” Therefore, continue typing vour
paragraphs until vou are ready to start the next section at this level . . . . [section continues].
Second Level One Heading
Now you have divided vour paper into two subheadings, the minimum number of
divisions. You can make more divisions—as many as vou like. . . . [section continues].

Paper with Two Levels of Heading

is not considered one of the 5 heading levels

>

First Level One Heading
The text begins here. You can have as many paragraphs as vou like under this heading. If
vou are dividing the paper into sections, you know you will need at least one more heading at

Title appears on first page and title page. Title A
APA HEADINGS

this level because you cannot “divide” your paper into “one.” Therefore, continue typing your
paragraphs until vou are ready to start the next section at this level . . . _ [section continues).
Second Level One Heading

Now you have divided your paper into two subheadings, the minimum number of
divisions. You can make more divisions—as many as you like. If you want to subdivide a
Level One Heading section, use Leve! Two Headings to divide it as shown here.
First Level Two Heading

With the Level Two Heading, you have just indicated to readers that you mtend to
subdivide your Level One Section into further subdivisions. You can subdivide it as many times
as you want, but vou must subdivide 1t at least twice. . . . [section continues).
Second Level Two Heading

Are vou getting the hang of it? You now have vour second subdivision of the big section
called "Second Leve! One Heading " . . . [section continues). |

D VR S T S W
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Paper with Three Levels of Heading

is not considered one of the 5 heading levels

Title appears on first page and title page. Title
APA HEADINGS 2

First Level One Heading

Ora avete diviso la vostra cartain due sottotitol, il numero mmumo di divisioni Potete
rendere piu divisioni -- altretante mentre gradite. Infatti, potete dividereisottotitoli se desiderate
a.Supponga che, allintemo del sottotitolo uno, desiderateulterion suddivisioni Dovete usare
appena uno stile di secondano-sottetitolo per distinguere le suddivisions dai piu grandi sottotitoli
.- .. [s@cton consnues)

Second Level One Heading

First Level Two Heading

Il testo peril sottotitolo il numero uno conancia qui. Se state dividendola cantanelle
sezioni, sapete che avrete bisogno almeno di unnuovaintestazone a questolivello perché non
potete "dividere” la vostracana "inuna."d conseguenza, cortinuerete a scrivere i vostn

paragrafi a macchina fino a chenonsia

- - Note capitalization of level 3 headings:
Firstlevel three headin® Und capitalize only the first word and proper nouns.

paragrafo, comeillustrato qui Iriziate s Levels 1, 2, and 3 are boldfaced. e

di suddivisione allinizio del paragrafo, italicize lintestazione ¢ disponete unperiodo allestremata
di esso per separarli daltesto diparagrafo. . . . [secton contnuesy)

Secondlevel three heading (Gia avete imparato che se cominaate dividere una sezione,
dovete avere almeno due divisioni a quelhivello. Questo paragrafo € la seconda suddivisione
secondana del sottottolo il numero due. . . . . [section consnuss]

Second Level Two Heading

Lemtestaziomillustrate in questo campione possono osservare pocoun dispan (e forse
alesaggio)a voisenonliavete usati prima Tuttavia sono standard per senittura academic.Voi
probabilmente non desidererebbe usare le intestaziors di academic-stile perun opuscolo o per
fare pubblicita; ma servono di senttura academic convenzionale di affan una centa & - senttwra -

perché sono profilo basso e non distract daltesto. . .. [secton consnuas]|
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Papers With Four Levels of Heading

is not considered one of the 5 heading levels

Title appears on first page and title page. Title
APA HEADINGS 2

First Level
Ora avete diviso 1a vostra carta in due sottotstol 1l numero minmmo di division. Potete
rendere piu division: -- altretante mentre gradite. Infatt, potete dividere 1 sottotitoli se desiderate
a.Supponga che, all'mterno del sottottolo uno, desiderate uitersori suddivisioni Dovete usare

One Heading

appena uno stile di secondario-sottotitolo per distinguere le suddivisions dai pi grandi sottotitols
. [secton contnues)

First Level Two Heading

I1 testo per il sottotitolo il numero uno comincia qui.Se state dividendo la carta nelle
sezioni, sapete che avrete bisogno almeno di unnuova meestazione a questo livelloperché non
potete "dividere” la vostra carta "m una "di conseguenza, contmuerete a scrivere i vostn
paragrafi a macchina fino a che non siate pronti per. . .. [sacton continues).. . .

First level three heading Uno stile prefento spesso & suddivisione livelata di
paragrafo, come illustrato qui Iniziate semplicemente un nuovo paragrafo, mettete l'intestazione
di suddivisione all'mizio de! paragrafo, italicize l'intestazione ¢ disponste un periodo allestremita

di es%0 per separarti dal testo di parags Note capitalization of level 3 and 4 headings:
First level four heading. Dittav| Capitalize only the first word and proper nouns.
Levels 1, 2, and 3, and 4 are boldfaced. Level 4

probabiimente non desidererebbe usare B licized,
fare pubblicita; ma servono di scritura

profilo basso e non distract dal testo. .. . [secton continues]

Second level four heading. \'o1 probabiiments non desidererebbe usare le mtestaziom di
academic-stile per un opuscolo o per fare pubblica; ma servono di scrittura academic
convenzionale di affari una certa ¢ perché sono profilo basso ¢ non distract dal testo. ... . {secton

contnues)
Second level three heading Gia avets imparato che se cominciate dividers una sezione,

dovete avere almeno due division: a quel livello. Questo paragrafo & la seconda suddivisione
secondaria del sottotitolo 1l numero due. . ... [saction contnues)
Second Level Two Heading

Le intestazion: illustrate in questo campione possono osservare pocoun dispari (e forse
alesaggio) a voi se non li avete usati prima Tuttavia, sono standard per scrittura academic....

[secton contnues]

NOTE: Level 5 headings are not illustrated here because they are rarely used outside
dissertations. Level 5 headings, if used, look like level 4 without the boldface.
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Headings in an Appendix [2.13]

If your paper contains an appendix (see APA section 2.13), type the word appendix as you would type the
title of your paper (centered, not boldfaced or italicized, major words capitalized, [see APA p. 39]). The title
of the appendix is separate from any headings used within the appendix. If headings are used within an
appendix, follow heading guidelines used in the paper, beginning with level 1.

How do | avoid "orphan" headings?

Headings that stand alone on a line can get separated from their text when they occur at the bottom of a

page. (Turning on widow/orphan control won't help with headings.) Although the APA shows "orphan” n
headings in its sample papers (pp. 41-59) , many people prefer to avoid them. Do not press the Enter key
repeatedly to move a heading to the next page because doing so will leave blank lines in your paper when

you revise and cause other headings to move.

To prevent headings from separating from the text, follow these instructions for Microsoft Word 2007 users:

Place the cursor in front of the heading .

On the Ribbon Bar, select either the Home tab or the Page Layout tab.

Find the Paragraph section and open it (small arrow to right of "Paragraph™).
Click the tab for Line and Page breaks.

Click Keep with Next

Click OK

If you find yourself using this function repeatedly, you may want to put a "Keep With Next" shortcut on the
Quick Access Toolbar. For instructions, go to the "Using Microsoft Word for APA Tasks" section of this *
booklet.

ourwNE

LISTS IN THE TEXT (SERIATION) [3.04]

For word processing instructions, see "Using Microsoft Word for APA Tasks" in this booklet.

Using Bullets
The APA allows the use of bullets, rather than numbers, for vertical lists when the order of items is not a
factor. To create a bulleted list, use the auto-formatting function on the Home tab of the Ribbon bar:

The bullets should be Y2 inch from the left margin, in line with paragraph indents. Bulleted lists summarize.
They should not replace a detailed explanation or commentary.
¢ Items in bulleted lists must be grammatically parallel (see parallelism in this booklet and in the
APA manual).
o Bulleted lists are double-spaced like the rest of the text.

Using Numbers

Use numbers instead of bullets when the order of the items is important—for example, in presenting a set of
ordered steps in a process. Follow the formatting directions for bullets .

Using Lettered Series Within a Paragraph or Sentence [p. 64]

When a series or list of items appears within a sentence or paragraph, the items can be—but don’t have to
be—designated by letters (not numbers) in parentheses. The APA manual, p. 64, provides very clear
examples. Whether the items are in a single sentence or not, remember the serial comma—that'’s the
comma before the last item, as in the following two examples [APA 4.03]. (Examples below are single-
spaced but should be double-spaced in your paper.)

EXAMPLE 1: Unlettered Seriation in a Sentence

Researchers divided participants into four groups on the basis of age, gender, height, and weight.

Serial comma
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EXAMPLE 2: Lettered Seriation in a Sentence or Paragraph

In the text, cite all the research sources you used to produce your text, even if you don’t quote the sources
directly. Cite each source each time you refer to it in your paper. Citations serve three functions: (a) to give
credit to the persons whose ideas you used, (b) to allow readers to find your original sources, and (c) to
establish the credibility of your presentation. Most of the time, you will comment on or paraplirase the ideas
of others. Occasionally, you will provide direct or indirect quotes to emphasize or clarify a point. “Note,
however, that you must cite sources, regardless of whether you quote or paraphrase.

Serial comma

TABLES and FIGURES [5.01-5.30]

Use tables and figures sparingly, and only if the information contained in them is essential for understanding
the text of your paper. Tables and figures should supplement, not duplicate, what is expressed in the text.
Mention the table or figure at the appropriate point in the text. Refer readers to the table or figure with words
such as

As shown in Table 2, the results were . . .

configuration of parts (see Figure 1) depended upon . . .

Numbering and Placing Tables and Figures

e Assign numbers to table or figures in order of their appearance in the text, and number them
separately from one another (i.e. Table 1, Figure 1) [5.05].

o Provide a title [5.12] for each table and place the title above the table, after the table number (see p.
132 of APA manual for illustration).

o Provide a caption [5.23] for each figure and place the caption beneath the figure, after the figure
number (see 159 of APA manual for illustration).

e APA style places tables and figures on separate, unnumbered pages after the Reference page.
However, many University programs prefer that each table and figure appear in the text at the point
where it is first mentioned. Check with your instructor, advisor, or program director for the preference
of your program.

o If the table or figure appears in an appendix, the appendix letter appears before the number of the
table or graph, e.g., Figure A2.

¢ In APA style, tables have horizontal lines but not vertical lines.

Citations for Tables and Figures

Doctoral students must obtain copyright permission to use table and figures from another source in their
dissertations, and must include a copyright permission footnote (explained on p. 38 of the manual) in
their text. For students not submitting papers for publication, the following guidelines are summarized
from the APA manual.

¢ If you obtained a table or figure from another source, you must, according to the APA manual, “give
credit in the table or figure caption to the original author and copyright holder” (p. 128).

¢ If you created the table or figure yourself, but within the table or figure you used information
reproduced or adapted from another source, you must provide a source note (similar to a reference
entry) at the bottom of the table or figure. No entry is needed on the reference page unless that
source was cited elsewhere in the paper. See APA 5.16 for examples of table source notes, and
5.23 for examples of figure source notes.

APA rules governing tables and figures are complex. For clarification or additional information refer to the
APA manual, Chapter 5 or to the manual's index.
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Table Example (size reduced) Error! Bookmark not defined.
Table 1

Tirle of Table

Ist column
heading 2nd heading  3rd heading  4th heading

Begin text here. You Use the tab
mav single-space or  kev 1o move
make the text smaller from one

to improve table cell to

readability the next.

Table material Material XX LAY
Table material Material XX XX
Table material Alaterial XX XXX
Table material Material XX XXX

Notre: Any notes necessary to explain the table, or to identify
the source in information used in the table, should be placed
here, preceded by the heading "note" as shown. If the table is
reproduced or adapted from another source, give a table
source nofe here but not on the reference page (unless the

source is cited elsewhere in the text.

Figure Example (size reduced)

3.5 ;_P
3 | A oseries 1

25 A i | w Series 2

2 .,/_ | Series 3

Category 1 Category 2 Category 3 Category 4

Figure 1. Tvpe the caption here. The caption (a brief description of the contents
of the figure) serves as a ritle. For more on captions see APA 5.23, If the table is
reproduced or adapted from another source, give a table source note here but not

on the reference page (unless the source is cited elsewhere in the text. |
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PART TWO: TIPS TO IMPROVE YOUR WRITING

"FLOW": HOW TO IMPROVE IT

What is "flow"? People sometimes use the informal (and imprecise) term flow, as in "does my paper flow?”
when they want to know if readers can follow ideas easily. This quality of discourse called "flow" (writing
professionals refer to it as coherence) is influenced by a number of factors. Flow, or coherence, cannot be
addressed as a single concept; it needs to be analyzed to identify its underlying components.

Keep in mind that academic writing is different in a number of ways from less formal discourse such as
personal letters and reflections, newspaper articles, and advertising brochures. First, of all, academic
writing usually involves complex and abstract concepts, explained thoroughly and objectively. Academic
writing often employs specialized vocabulary requiring definitions or context clues. In addition, academic
writing is idea-dense, which means that a lot of information is conveyed in a small space. Itis also high
stakes writing, in that misunderstandings by readers can be costly. Finally, academic writing must be
understood by a worldwide audience of English readers, in whose countries another English dialect may
prevail. For all these reasons, academic writing must follow a strict model of Standard Formal English, the
model shared by most academics around the world.

Because of the complex and high stakes characteristics of academic and professional writing, readers must
rely more heavily of the structure of the text to understand it, text structure that includes consistency,
organization, grammar, transitions, and diction.

Factors That Affect "Flow"

e Consistency. Keep terminology consistent. If you are writing about the relationship between
"company service representatives” and "customers," don’t call them "company staff" and "clients" in
the next sentence or paragraph. Keeping the terms consistent throughout the paper helps readers
concentrate on concepts instead of trying to figure out if you are still referring to the same thing, or
why you changed the terms. It's good to avoid unnecessary repetition, but consistency is not the
same as repetition—or, if you prefer to think of it this way—consistency is "good" repetition.

e Headings. Headings and subheadings are essential to organization. They provide a quick overview
of content; they establish logical relationships among sections of the paper and provide transition
from one section to another. Imagine yourself driving through a large foreign city without road signs
marking highways and streets. Readers experience something similar as they navigate a paper with
no headings. Here is the best part: Headings keep the writer, as well as the reader, organized.
Establishing headings before you write helps keep you focused. For tips on effective headings, read
the "Headings" section of this booklet.

e Pronouns. Pronouns replace or "point to" words you have used previously in your text: Students
learn more from teachers who inspire them. If the connections are unclear, the ideas become
disconnected. To avoid pronoun confusion, read "Pronouns: Avoid Confusion" in this booklet, and
follow up with appropriate sections of the APA manual.

¢ Quotations. Quotations disrupt the flow of ideas and mix writing styles. If you must use a quotation,
keep it very short. Avoid quoting complete sentences and paragraphs. Read the "Quotations"
section of this booklet for do's and don'ts.

e Audience. Disruption to flow occurs when there are gaps in information or disorganization in
presenting it. Gaps and disorganization occur when the writer forgets the audience. We tend to be
egocentric when we compose, thinking of what we know or intend to say rather than what the reader
needs to know or might misinterpret. Try to read your own paper from an audience point of view.

e Transitional devices. If you read the second paragraph under the heading "FLOW: How to Improve

It" above, you will see examples of transitional devices: First of all, . . . In addition, ... also. ..
Finally, . . . For all those reasons. These transitional words and phrases keep nudging the reader
forward and then, finally, announce a summary statement, "For all those reasons. . .. " You will find

a list of transitional words and phrases in this booklet under the "Transitions" heading.

Some transitional devices are non-verbal: for example, (a) alphabetized lists within paragraphs, (b)
numbered lists arranged vertically, and (c) bullet points.
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e Organization. When you think about organization, think about levels. The entire paper has an
organization; sections of the paper have organization; paragraphs have organization; and, yes,
sentences have organization.

1. Overall organization. When you consider the organization of your paper, ask yourself, What is
the most logical way to present this particular topic?: chronologically? climactically? most-to-
least important? cause and effect? compare and contrast? problem and solution? myth vs. fact?
sequence of steps? reverse order? Remember that after you decide on an overall organization,
you may decide to use another organizational method within a specific section.

2. Section organization. The organization of a section depends upon the purpose of the section.
Let's take a literature review section as an example here because many students struggle with
the flow of the literature review. The purpose of most graduate literature reviews is to
synthesize (integrate, interrelate) conclusions of others to arrive at a more-informed conclusion
or to answer a question. Therefore, literature reviews are generally organized thematically: that
is, by subthemes of the big topic. You can determine the subthemes before you start the
research (I want to answer the question, what factors support independent learning in adults? |
probably need to know about motivations of adult learners, social characteristics of adult
learners, cognitive functioning of adult learners—so these will be my subheadings). But as you
read the literature, you keep running across another theme you call "psychological barriers," so
you may add or replace a subheading. Organizing a literature review section by presenting one
article summary after another, instead of thematically, is guaranteed to confuse your readers
(and probably you).

3. Paragraph organization. Not all paragraphs need to be organized exactly the same way (ho-
hum), but most paragraphs should contain a topic sentence stating the main idea, followed by
supporting statements (examples, illustrations, explanations, and so on). Refer again to the
second paragraph under “Factors That Affect Flow" above. What do you notice about its
organization? Look at another paragraph organization, this time under the heading "Headings."

o Parallelism. Did you notice that sentence organization was not addressed under the "Organization"
heading? That is because an important aspect of sentence organization falls into a special category
called parallelism, which refers to grammatical "sameness" within elements of a sentence. You can
read about this under the "Parallelism" heading in this booklet. Poor parallelism will not go with your
flow.

While we are on the subject of sentences as organization, take note that the standard word order of
an English sentence is [subject]+[verb]+[object-or-modifier]. For example,

Sue hates fruitcake. Sue [subject] hates [verb] fruitcake [object].

Ahmed feels frustrated. Ahmed [subject] feels [linking verb] frustrated [modifier of
subject].

Whenever you find yourself with a disorganized sentence, reduce it to its simplest form:
subject+verb+object-or-modifier. If you can't identify those three elements, rethink the idea and try
again. If you identify several subjects, verbs, and objects or modifiers, you may need more than one
sentence to express the idea.

e Wordiness. A section of this booklet is devoted to the problem of wordiness, and you should read it.
Keep in mind that the human brain can't process more than a few bits of information at a time. When
we read, we "chunk" together bits of information into meaningful ideas. When you introduce
unnecessary words into your presentation, you place a heavier burden on the reader's ability to
process the information: it's harder to "chunk" together all those extra bits of information (words).
Eventually, the reader loses the flow. Wordiness comes naturally to all writers--in part because we
test out several ways of saying the same thing, but forget to delete some of them; in part because the
words we write are hard-earned, and we hate to give them up. Learn to locate unnecessary words.
Your readers will thank you. Your flow will be improved. Your grades will rise.

e Repetition. No doubt previous writing teachers told you not to repeat yourself. Your teachers forgot
to add the word unnecessarily. Repetition of key words and phrases can enhance flow by helping
readers relate themes and identify patterns. If you need to repeat a key point, do not say "as stated
earlier"; just do it. Your readers know you stated it earlier, and if they don't, don't remind them that
you are repeating yourself. Repetition can also be useful as a rhetorical device to emphasize a point.
If you doubt that, read Dr. Martin Luther King's "I Have a Dream Speech." You can find a much
humbler example if you go back to the second paragraph under the “FLOW'": How to Improve It"
heading. Does it leave any doubt that this booklet deals with a specific style of writing?
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e Verb tense. Unnecessary or illogical changes in verb tense cause readers to stop and scratch their
heads, wondering where they are in the flow of time. APA simplifies verb tense choices by insisting
on (a) past tense for the reporting of outcomes, (b) future tense for relating proposed or expected
actions, and (c) present tense for expressing current or ongoing conditions. So . ..

Past: Barnes argued . . . Bosso announced . . . Nguen predicted . . . They observed . . .
Future: | will interview . . . participants will be chosen . . . they will return the surveys . . .
Present: Obama believes . . . the earth revolves . .. women live longer . . .

Note the difference: AS a group, smokers have a higher rate of heart disease.
As a group, smokers in the study had a higher rate of heart disease.

APOSTROPHES
To Show Ownership or Possession

e Add an apostrophe and an s ('s) to words that don't end with an s.
somebody's car (the car belonging to somebody)
the men's locker room (the locker room of the men)
a month's rent (the rent of a month)

e Add only an apostrophe after the words that already end in s.
twelve days' pay (that is, the pay for twelve days)
the students' tests (that is, tests belonging to the students)

e To show joint possession, add an apostrophe and s to only the last word in the group: e.g.,
Laurel and Hardy's last movie (a movie by the team of Laurel and Hardy.)

¢ But to show individual possession, add an apostrophe and s to each word in the group: e.g.,
Fossum's and Day's opinions (the opinions of Fossum, and the opinions of Day)
To Form Contractions Note: Do not use contractions in academic papers.
Show Omission of Letters with Apostrophes
Could not = couldnt Heis=he's They are =theyre Cannot = can’t
Correct an Especially Troublesome Error

It’s (a contraction) means it is (e.g., It's not snowing now).
Its means belonging to it (e.g., The school lost its funding).

To test for correctness, ask yourself, “Do | mean it is?”
Avoid Misuse of apostrophes.
Do not use an apostrophe for simple plurals.

wrong: All the player's knew this was the last chance to score.
Right: ~ All the players knew this was the last chance to score.

Do not use an apostrophe for pronouns that already indicate possession.

Wrong: We didn't know the suitcases were her's (you's, their's, our's).
Right: We didn't know the suitcases were hers (yours, theirs, ours).

In APA style, do not use apostrophes for plurals of numerals or letters.
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CAPITALIZATION RULES [pp. 101-104]

1. PROPER NOUNS Capitalize persons, places or things only when they are used as hames or titles

of specific entities (proper nouns).

Right:  Both authors taught at Purdue University, but each received a degree from a
different university.

Wrong: The authors developed language programs at their respective Universities.

Right: A dispute arose between assembly line employees and their management staff.
Wrong: Interns are assigned two Supervisers during their year-long program.

Right:  The symposium featured a presentation by Professor Robert Reich.

Wrong: Students agreed that the Professer's lectures were boring.

Right:  Two dog breeds that make good pets for children are beagles and Labrador retrievers.

. ACADEMIC COURSES Capitalize academic titles, but do not capitalize general courses of study
unless they contain a proper noun.

Right:  Philosophy 212 was recommended for its emphasis on analytical writing. (Title of
a specific course)

Right:  Dr. Feldman teaches "A History of the Middle East Conflict" each spring. (Title of
a specific course)

Wrong: | need to take a course in Histery and a course in Ecenemies to fill my requirement.
(These are academic subjects, not course titles)

Right:  Courses in philosophy and British literature are required for graduation. (The first is an
academic subject, not a course title; the second is also an academic subject, but it contains a
proper noun that requires capitalization.)

. THEORIES AND DISORDERS Do not capitalize the names of theories, disorders, or processes
(but do capitalize proper nouns that appear in them).

Right:  Stem cell research may lead to a cure of Alzheimer's disease. (The disease is named
after Aloysius Alzheimer, the scientist who identified it.)

Right  The apparent rise in cases of autism spectrum disorder may be attibuted to better

diagnostic techniques rather than an increase in actual occurrences. (The name of the
condition is not based on the name of a person or place and therefore not capitalized.)

Wrong The therapeutic approach that most appeals to me is Cegnitive Behavior Fherapy
(CBT). (Keep the captials for the abbreviation, but do not use them to name the theory.)

. TITLES AND HEADINGS IN THE BODY OF THE PAPER Capitalize the first letter of each word in a
title you use in your text, except for the following (unless any of the following are the first word of the
title):

a. and, but, yet, so, for, or, nor (coordinating conjunctions)

b. a, an, the (articles)

c. as, at, by, for, in, of, off, on, out, to, up (prepositions of three letters or fewer)

Right: J. G. Farrell (1927) described the breakdown of civil society in The Siege of
Krishapur.

Wrong: The professor assigned a new book, ALONGTHE BELACKHAWKTRALL, for
next week. (Should be Along the Blackhawk Trail)

Wrong: The title of my essay was "A-day-in-the-life-of-an-unhappy-wife:" (Should be “A Day

in the Life of an Unhappy Wife”)

NOTE: For formatting on titles used on your reference page, see “ TITLES ON YOUR REFERENCE
PAGE.”
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5. PLANTS AND ANIMALS Do not capitalize plants or animals unless they are also proper nouns.
Right:  The council passed an ordinance prohibiting pit bull dogs inside the city limits.

Right:  Veterinarians recommend that Russian wolfhounds be exercised every day.

6. DAYS OF THE WEEK Capitalize days of the week but not seasons of the year.
Right: A committee of pyschiatrists meets every Thursday.
Right:  Every summer my daughter studies in England.

Wrong: Congress will recess during the Winter holidays.
7. DEFINED GEOGRAPHIC REGIONS Capitalize directions that refer to specific geographic regions
of the country. Do not capitalize those that refer to general directions.

Right:  Americans from the South speak slowly and emphasize vowel sounds, while
Northerners speak more rapidly and clip their vowels.

Right:  The school is situated on the south side of the boulevard.

Wrong: Students walked West for six blocks and found the bridge.
8. Capitalize nouns followed by numerals or letters.

Right:  Interview transcripts are provided in Appendix C.

Right:  For an explanation of variables, turn to the Data Analysis section of Chapter 5.

CAPITALIZATION IN QUOTATIONS

Examples in parentheses refer to the Publication Manual of the American Psychological Association (6" ed.).

*Capitalize the first word of a quote that is a complete sentence.
¢ Harris (2000) remarked, “Finding information is an art, not a science” (p. 214).

e According to Plotnik (1982), “The licensing or copyright agreement with the author does not cover
items the author borrowed from another source” (p. 16).
¢ (APA example on p. 118, Quotation 1, and on p. 293)

However, if the quoted sentence completes an unfinished sentence or follows the word that, do not
capitalize the first word or precede it with a comma.

o Sutter was fascinated with Lake Superior because “the ore boats and foreign freighters seemed
impossibly exotic” (p. 2).

e Quincy acknowledged that “negotiations over bride price sometimes involved more than the price of
the bride” (p. 105).

e (APA example on p. 118, Quotation 2, and on p. 120)

*Do not capitalize the first word of a quoted phrase that is an incomplete sentence).

e Bryson (2002) called the English language “a merry confusion of quirks and irregularities that often
seem willfully at odds with logic and common sense” (p. 93).

*If the quote is interrupted, do not capitalize the first word of the resumed quote.

e "People and places,” noted Zinsser (1992), “are the twin pillars on which most nonfiction is built” (p.
54).

*Hacker, D. (2003) A writer’s reference, p. 284. Boston, MA: Bedford St. Martins.
*Harris, M. (2000). Prentice Hall reference guide to grammar and usage (4th ed.), p. 229. Upper Saddle
River, NJ: Prentice Hall.
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PARALLELISM: Improve Sentence Construction

Parallelism means that all sections are grammatically equal or balanced. Consider the following example:

Whenever Harry has free time, he enjoys sailing, hiking, and he plays basketball.

Remember that old jingle from Sesame Street? ﬂ Whenever Harry has free time, he enjoys
. . (a) sailing,
One of these things is hot like the others . .. JT —» (b) hiking,
and
What is not like the others, of course, is the phrase (c) to play basketball. to
play basketball. It is grammatically unparallel. The

sentence would be better written as follows:
Harry enjoys sailing, hiking, and playing basketball.
That way, each of the three elements is expressed in grammatically parallel form.

Parallel sentences are easier for readers to grasp, and they indicate that you have thought through carefully
what you intend to write. Everyone would understand (though maybe not appreciate) the sentence about
Harry, even if it weren’t parallel. The sentences you write in your paper, however, are likely to be more
complex and carry more sophisticated messages than Harry likes sailing, and their ideas much more
sophisticated, causing readers to rely more on the grammatical structure.
Here are two examples of sophisticated sentences with parallelism problems:
1. Example 1

Unparallel

The course instructor helped us see the necessity of designing meaningful curriculum,
meeting the required standards, and-to keep the-human element in mind.

Parallel

The course instructor helped us see the necessity of designing meaningful curriculum,
meeting the required standards, and keeping the human element in mind.

2. Example 2
Unparallel

Johnston hypothesized that with drug X;-post-o

perative recovery would be fast, improved
respiratory status, and with better pain-control tha

rati
an-drug Y.
Parallel . . . but

Johnston hypothesized that with drug X;post-operative recovery would be fast, respiratory
status would improve, and pain contret-would be better than drug Y.

The sentence still has problems because the comparison is not clear and the parallel elements are
awkward; so let’s take the sentence a step further:

Parallel and Improved

Johnston hypothesized that, in comparison to drug Y, drug X would speed post-operative
recovery, improve respiratory status, and provide better pain control.

In the last example, each element begins with a simple verb to eliminate the awkward and repetitious
would be construction. Also, the comparison is clarified by placing the items being compared—the
drugs—in the same part of the sentence.
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PRONOUNS: Avoid Confusion
To avoid repetition of nouns, writers use pronouns as substitutes for nouns already named.

Jamison told the woman that his (Jamison's) table was wobbly because his (Jamison's) son had lopped off
its (the table's) leg with his (Jamison's son's) toy saw.

Pronouns are extremely useful as long as their antecedents (the words they stand for) are absolutely

clear. When pronouns are vague—when their antecedents are not clear—readers are left to guess at
their meanings. Such guessing irritates readers and causes misinterpretations. (Lawyers know a lot

about pronouns!)

e Make sure that pronouns refer to something specific and that what they refer to cannot be
misunderstood.

Managers wanted new policies immediately, but this didn't happen until June.

What exactly does this stand for in the sentence above? This managers? This policies?

No single antecedent exists for this. The sentence needs to be recast. Here are some possibilities:
Managers wanted new policies immediately but didn't get them until June.
Managers wanted new policies immediately, but these new policies weren't implemented until June.

This, that, these, and those are pronouns frequently used carelessly, leaving readers to ask, "This
what?" "That what?"

e Do not use this, that, these, or those unless the antecedent has already been named.
Wrong: Suddenly this woman rose from her chair and stalked out.

Unless this woman has been introduced to readers in a previous sentence, they will wonder," What
woman?" Say “a woman.”

e [f you have trouble with vague pronouns, avoid using this, that, these, and those all alone.

Edwards' boundless optimism creates high expectations on a limited budget. That worries his
supporters.

What worries Edwards' supporters: his optimism, the high expectations, or the budget? The word that alone
doesn't tell us. Use the appropriate term after that. For example,

Edwards' boundless optimism creates high expectations on a limited budget. That optimism worries his
supporters.

Double check your use of which, that, who. Readers usually associate a pronoun with the noun
closest to it.

Homeless people waited for hours in the cold rain to get into the shelter, which made many of
them ill.

How alarming to think that the shelter made them ill! That's what the sentence suggests, however. The
word which is associated with the noun closest to it: shelter. Recast the sentence to place which next to

the noun it refers to:

To get into the shelter, homeless people waited for hours in the cold rain, which made many of
themiill.

Perhaps it wasn't just the cold rain that made them ill. To include the waiting, recast the sentence again,
this time eliminating which:

Waiting in the cold rain for hours to get into the shelter made many of the homeless people ill.

e Avoid the Great Unnamed.
It was not revealed by the authors why only women were included in the trial.

It seems not to refer to anybody or anything in the sentence. (Actually it refers to the entire phrase why
only women were included in the study, making its use redundant. ) Recast the sentence:

The authors did not reveal why they had included only women in the trial.

e Never use you in academic writing.
The study showed that you can reduce the risk of stroke by taking one baby aspirin per day.
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The use of you suggests a specific reader, who, even if known, should not be addressed directly. Such
direct forms of address are just too chummy for academic or professional writing. Recast the sentence:

Showen (2000) concluded that taking one baby aspirin per day can reduce the risk of stroke.
e Never use we/us or they/ them unless those pronouns refer to specific individuals.
We know that people pay attention when their money is at stake.

Who are the we in the sentence above? The writer is including himself and some unspecified others.

Unspecified means vague. The use of we creates another rhetorical problem: by including all readers,

the writer ensures that somebody will disagree. Using we to mean everyone challenges someone to
disagree, thereby creating the opposite effect intended.

If a work is co-authored, using we to refer specifically to the authors is fine:

We (the other author and 1) designed the study to exclude girls between the ages of 6 and 8 years.

Am | allowed to use "I" or "we" in a paper? [APA p. 69]

Yes. In fact you should. If you refer to yourself as "the author" when describing your methods, you will
confuse readers, especially if your paper contains references to other authors. When you describe your
methods, use "I" (or "we" if you have co-writers). The APA addresses the issue on p. 69 under two
headings: "Third person" and "Editorial we."

TRANSITIONS and CONJUNCTIONS: Punctuation and Meanings

Coordinating Conjunctions: for, and, nor, but, or, yet, so

1. Lucy didn’t like the way the contest was run. She let the judges know it.
2. Lucy didn't like the way the contest was run, and she let the judges know it.

The second example is a compound sentence—two independent clauses joined by coordinating
conjunction.

Punctuation Rule: Use a comma before a coordinating conjunction when it joins two independent
clauses.

Subordinating Conjunctions: as, after, although, because, before, if, when, while, since, until, unless, so

(that), whether, even though

1. The contest was unfair. Many people did not applaud for the winner.
2. Because the contest was unfair, many people did not applaud for the winner.
3. The winner could not enjoy her victory because she knew the contest was unfair.

The last two examples are complex sentences--one independent clause and one dependent clause.

The dependent clause starts with a subordinating conjunction.

Punctuation Rule: When a dependent (incomplete) clause begins a sentence, use a comma at the

end of the clause. When the independent (complete) clause begins the sentence, a comma is not
necessary before the conjunction.

Adverbial Conjunctions: consequently, furthermore, however, in fact, indeed, likewise, moreover,
otherwise, therefore

1. Everyone wants a new set of rules. Changes are not possible until next year.
2. Everyone wants a new set of rules; however, changes are not possible until next year.

The second example is a compound sentence—two independent clauses

Punctuation Rule: Use a semicolon between the independent clauses and a comma after the
conjunction.

Transition Words: Adverbial conjunctions can be used as transition words, but so can many other words.

Examples are simple sentences—one independent clause each.

1. Everyone wants a new set of rules. However, changes are not possible until next year.
2. Everyone wants a new set of rules. Changes are not possible, however, until next year.
3. Everyone wants a new set of rules. Changes are not possible until next year, however.

Punctuation Rule: Punctuate the sentences and then set off the transition words with commas.
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TRANSITIONS AND THEIR MEANINGS

Transitional words and phrases link ideas in one clause or sentence with those in the next. They help the
reader see the relationships between ideas. Think of them as bridges linking one idea to another, or as road
signs that lead the way.

Some of these words may be used between independent clauses that have been joined by a semicolon. In
that case, they are called adverbial conjunctions, and they are set off by a comma. Note this example: Lara
was loud, bossy, and insensitive; consequently, people avoided her whenever possible. Transitional
expressions placed elsewhere within the clause are punctuated with commas. Here are some frequently
used transitional expressions and their most common uses.

Example: specifically, for instance, for example, to illustrate, in particular, especially, most importantly

Addition: also, furthermore, besides, likewise, moreover, again, finally, in addition, in the first (second,
third) place, what is more, at last, next, beyond that

Comparison and Contrast: Comparison: similarly, likewise, at the same time, in the same way, in like
manner Contrast: however, nevertheless, still, nonetheless, conversely, rather, whereas, on the one hand,
on the other hand, on the contrary, by contrast, in contrast

Repetition: again, in other words, once again, to repeat, as stated

Cause and Result: therefore, thus, hence, consequently, as a result, all in all, for this/that reason, because

Conclusion: finally, then, thus, hence, therefore, in conclusion, to summarize, in short, all in all, in brief, on
the whole

Time: earlier, before, since, subsequently, eventually, gradually, meanwhile, simultaneously, now,
immediately, recently, suddenly, currently, during, then, next, after a while, at last, in the meantime, until now

Concession: doubtless, surely, certainly, naturally, granted, no doubt, admittedly

Place: elsewhere, here, there

Avoid Confusing Transitions and Conjunctions: Don’t make readers guess at your meaning.

Avoid using since when you mean because. Since the troops returned from the war, boot sales have been
increasing. Have boot sales been increasing because the troops returned or only from the time they
returned?.

Since had a temporal meaning: from that time until now. Because means only one thing: for the reason that.

Avoid using while when you mean although. While senators were on recess, the President was busy writing
administrative orders. Do you intend emphasize the contrast between the vacationing senators (although)
and the hardworking President, or do you want to say that the President was busy but just while the
senators were on break?

VERBS: ACTIVE AND PASSIVE VOICE [3.18]
Active Voice
Instructors often tell students to write in the active voice. What does this mean? Active voice emphasizes a
subject doing something, as in the following sentence:
Captain Hawes fired the gun.
| made a mistake.
Passive Voice
By contrast, passive voice emphasizes something done to a subject.

The gun was fired.
A mistake was made.

Passive voice emphasizes a different subject: in the examples above, passive voice places the focus on gun
and mistake, while active voice places the focus on who fired the gun and who made the mistake.

Passive voice can also leave out important information—who did the action—contributing to vagueness and
evasiveness.
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Active or Passive Voice?

In general, use the active voice because it is usually more direct, provides more information, and reduces
wordiness. Passive voice often requires more words than active voice to express an idea, thus contributing
to the problem of wordiness.

Active: Captain Hawes fired the gun.
Passive: The gun was fired by Captain Hawes.

Active: The President made a mistake.
Passive: A mistake was made by the President.

However, use the passive voice when you want to emphasize the receiver rather than the doer of the action:

Passive:  Tetracycline was increased to 50 mg.
Active: Researchers increased tetracycline to 50 mg.

Passive:  Students in Klein's (2003) study were paid $25 to patrticipate.
Active: Klein (2003) paid students $25 to participate in the study.

Use passive voice to avoid awkward and vague pronouns (like the pronouns you and we when they don't
refer to identified individuals):

Active: You can use fewer words, but you will lose important information.
Passive:  Fewer words can be used, but important information will be lost.

In this example, passive voice is a way to de-emphasize the vague subject, you, and place the emphasis on
what is done
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VERBS: TENSE FOR REPORTING RESEARCH [3.18, p. 78]

Research is always reported in the past tense. (Tense is the grammatical term for time.) Whatever was said,
done, written, etc. was done earlier and is not still being done. Note the earlier examples and their past
tense verbs. Here are some past tense verbs used for writing about research. These words have different
meanings, so select carefully for your context:

accepted accounted for advised advocated affirmed
agreed analyzed asserted claimed commented
concurred considered contradicted countered declared
defended demonstrated denied described disavowed
disclaimed discovered disputed dissented emphasized
established examined explained explored expressed
implied indicated informed inquired investigated
maintained mentioned noted observed offered
posited presented probed promoted proposed
guestioned recognized recorded recounted refuted
rejected related remarked reported repudiated
revealed stated studied suggested summarized
supported surveyed theorized urged

Although research is reported in the past tense (because the research was done in the past), sometimes
present tense is needed to express general truths or facts that exist in the present. Consider the following
example:

Gallileo claimed that the earth revolves the sun.

The asserting took place in the past, but the earth is still revolving around the sun.

WORDINESS: Eliminate It [3.08]

Wordiness refers to the habit of loading one’s writing with words that don’t contribute to the meaning. Why
do people do it? Sometimes because they’ve been assigned a 500-word paper, but have only 200 words of
ideas about the topic; so they toss in extra words, adding quantity without quality.

Other writers use extra words to obscure thier undeveloped thinking. When they’re not sure what they're
talking about, they try to cover it with words. Most readers, however, recognize the ploy. Writers who rely
on verbosity lose credibility with their readers.

Some writers are wordy without realizing it. They employ stock phrases without considering whether or not
they add meaning to their sentences. Below are some examples. Wordiness is a problem that should be
corrected when revising.

The Western style of academic and business writing requires you to (a) state ideas directly and clearly, and
(b) use as few words as possible to get the point across.

Avoid words that don’t add meaning:

The fact of the matter is that I'm tired = I'm tired

WORDY CONCISE

at this point in time now

in this day and age today
yellow in color yellow

In the month of November in November
an unexpected surprise a surprise

at that point in time then

due to the fact that because

end result result
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past history history

He is a person who can be trusted------------ He can be trusted.
in order to to

the field of computer science ------------------ computer science
There are many teens who smoke. ----------- Many teens smoke.
two different kinds two kinds

refer back to refer to

surrounded on all sides surrounded

There is no doubt that he lost. ----------------- No doubt he lost.

Unless you know that you are a very succinct drafter, you should plan to cut your wordage by 20% in your
first revision of each paper. Read through your work and find places to cut repetitions and unnecessary
wording. The following is an excerpt from a paper written for a management course.

The employees were not in agreement with the change in operational procedures
that the manager was wanting. Owing to the fact that they had much work to do, it was not
easy for them to adapt to new changes. What they were trying to express was that they were
dissatisfied, but there was a lot of resistance to their communication on the part of the
manager. It seems to me that the manager should have been able to work out some way to
let the employees of her company be heard by her. A manager who had good training would
have had an idea about what to do. Personally, I don’t think that the manager in this
company had been trained very well. As far as my opinion, | would have to say the poor
managers are the kind of people who don’t listen to what their employees are trying to say,
whereas good managers try to find ways for the employees to express themselves and then

try to respond to what the employees are saying. [179 words]

Now compare the paragraph to the following one, which has been revised for wordiness and redundancy:

The employees did not agree with the supervisor’s proposed procedural changes.
Because they had heavy workloads, they could not easily adapt to change. They tried to
express their dissatisfaction, but the manager resisted communication. The manager should
have listened to her employees. A well-trained manager would have known what to do.
Poor managers don’t listen, whereas good managers listen and respond to their employees’

feedback. [65words, with no significant change in meaning]
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FORMULATE A RESEARCH QUESTION AND THESIS

Once you have selected a topic, you might think you are ready to search for information—but hold on a
minute! Ask yourself, what do | want to know about this topic? If it's a topic you are familiar with, ask
yourself, what is the most important point to make about this topic? Such questions give you motivation and
focus, and they help you stay on track. You’'ll know what you're looking for: the answer to your questions.

An outline or overview—a roadmap, if you will—is very helpful at this point. You need to know where you
are going, how to get there, and when you have arrived. If necessary, or if you desire, you can revise the
outline and the research question as you proceed.

Your answer to the major research question is the thesis of your paper. Have you ever read something,
and afterwards found yourself asking, so . . . what’s the point? If there is no point, it's because the essay,
research paper, or editorial does not have a thesis—or at least not a clear one.

Sometimes you won't refine your own thesis until you’ve completed your research. However, you'll never
find the thesis without a research question.

WRITE AN ABSTRACT [2.04]

Abstracts can vary according to the purpose of the document and the instructor’s or publisher’s preferences.
The following points, however, are useful general guidelines. For additional information, including styles for
empirical studies, reviews or theoretical articles, methodological papers, or case studies, see Section 1.07 of
the Publication Manual of the American Psychological Association, 6™ edition.

Length

An abstract is less than one page, double-spaced. It is generally one paragraph ranging in length from
75 to 120 words.

Tips for Contents

= Write a comprehensive summary of the article, including conclusions.

= Indicate the purpose and scope of the information contained in the article.

= Describe the kinds of sources used (professional literature, observation, interview, etc.) or methods or
procedures, depending upon type of article.

= State conclusions, implications, and applications.

= Use key words used in the article that will enable database searchers (a) to discover your work in a
keyword search and (b) to decide whether your article is pertinent to their needs.

= Mention nothing in the abstract that is not included in the article.

= Be focused: Use specific nouns (e.g., elementary science teachers, not educators) and active verbs.

= Be objective: Summarize, but don’t evaluate or editorialize.

= Be concise; every word must count.

Tips for Being Concise

Do not repeat the title in the abstract.

Avoid citing sources if possible.

Use numerals (e.g. 32) rather than words (thirty-two).

Start with the most important statement about the article.

Include only the most important findings.

Do not include examples.

Avoid passive voice (e.g., not similar results were reported by three researchers . . . , but three

researchers reported similar results).

= Avoid starting sentences with “it is” and “there are” (e.g., not There were four studies that showed .
but Four studies showed).

= Avoid meaningless phrases like “This review was undertaken to compare x and y” (instead of” This

review compares x and y”)

APA Formatting

= The abstract follows title page and is numbered as page 2.

= Type the word Abstract one inch from top margin, centered, no italics or bold, only first letter
capitalized (Style 1 heading).

= Double-space throughout, including after title line.

= Use same font as body of article.
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Other APA Rules for Abstracts

= Avoid abbreviations if possible, but define them if used.
. Do not use quotes; if citation is necessary, use brief the form (author, pub date).
= Use third person (he, she, it, they) but not first (I, we) or second (you).

Works Consulted for This Section

American Psychological Association. (2001). Publication manual of the American Psychological Association (5th ed.).
Washington, DC: Author.

Hacker, D. (2003). A writer's reference. Boston: Bedford/St. Martin's.

Harris, M. (2000). The writer's FAQs: A pocket handbook. Upper Saddle River, NJ: Prentice-Hall.

Merriam-Webster's collegiate dictionary (10™ ed.). (2001). Springfield, MA: Merriam Webster.

Szuchman, L. T. (2005). Writing with style: APA style made easy (3rd ed.). Belmont, CA: Wadsworth

Purdue University Online Writing Center. (1995-2011). Reference List:Books. Retrieved from
http://owl.english.purdue.edu/owl/resource/560/08

NOTES
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PART THREE: USING MICROSOFT WORD® 2007-2010*
FOR APA TASKS

Directions for Mac users are at www.smumn.edu/tcwrite under "APA Resources" *
or click here

MS WORD® 2007, GENERAL TIPS

In a special section of this book, you will find directions for customizing and using the Quick Access Toolbar,
which can make your work faster and easier. The Writing Center offers fee-based workshops on using MS
Word for APA tasks (both for PC and for Mac users). For information about the workshops, visit our website
at www.smumn.edu/tcwrite, and click on Workshops. Refer to the table of contents at the beginning of the
booklet. For Word 1997-2003 instructions, go to www.smumn.edu/tcwrite, and look under APA resources.
MSWord 2010 users can follow directions for Word 2007 with few exceptions. Updates for MSWord 2010
users will be available at www.smumn.edu/tcwrite.

Backspace and Delete
The keyboard has two delete keys: Backspace and Delete. What's the difference?
= The Backspace key deletes characters and spaces to the left of the cursor (see the arrow pointing to
the left?).
= The Delete key deletes characters and spaces to the right of the cursor .

For example, in the sentence below—where the cursor has been placed
after the n in frustration—pressing the Backspace key twice will erase the n
and the o, whereas pressing the Delete key twice will erase the space and
the b.

Save yourself some time and frustration|by using the keys correctly.

Dashes and Hyphens

= Hyphens are used to connect words and parts of words. The hyphen key is located next to the 0 on the
keyboard. Type hyphens with no space before or after (for example, "a rags-to-riches story" ).

= Dashes are intended to separate words and phrases. To create a dash, type two hyphens with no
space before, after, or between them. Use dashes to indicate an interruption (e.g., "Students in Group
2—those who received no training—were least successful at accomplishing the task.")

Center Never center text by tabbing or spacing. If you do, any revisions will throw the text off
center. Use the Centering function of the word processor. It will automatically adjust centering as
you revise. You can center text before or after it is typed. If you center after typing, you’'ll need to
highlight the text, then center it. To center text,

Click the Centering icon == (on the Ribbon Bar's Home tab, Paragraph section)

B 9 - q '? r;u v Document2 - Microsoft V

Insert Page Layout References Mailings Review View
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Grammar Check
A word of caution about grammar check . . .

The grammar checker can be a useful tool, but it cannot think the way a human does. If you type something
that doesn't fit one of the grammatical patterns stored in the grammar checker's memory, it will give you an

"alert,” meaning it can't find a matching pattern. Think of the alert as a question rather than a command. It
is asking, Is this the pattern you really want? For example, the grammar check usually alerts writers to use
of the passive voice,* because passive voice is usually best avoided. However, it is not necessarily wrong,

and on occasion it may even be preferred to active voice. You must decide to keep, discard, or modify text
that sets off the grammar alert. Don't change something just because the grammar check highlighted it.

*Passive voice is explained in the Writing Center's Introduction to the APA and Other Writing Tips and in the
APA manual.

APA References and Word 2007

The 4" tab on the Word 2007 Ribbon Bar is References. If you click on it, you will see a listing for APA
style. Alas, the style is not correct. Word 2007 does not (1) format titles, volumes, or issues correctly; (2)
does not space lines correctly; and (3) does not create hanging indents. Aside from those shortcomings,
you may find Word's References useful. Just be sure to make the corrections after you use it. Throughout
this booklet you will find other ways Word 2007 can make APA formatting much easier.

Page Breaks |...Page Break...

Generally, the word processor automatically creates page breaks as your typing spills over from one page to
another. However, at times you need to force a page break: for example, at the end of the title page or
abstract, or before starting the reference page.

Do not force a page break by pressing the Enter key repeatedly. This will cause text to move down the
page every time you revise, leading to unsightly gaps between sections.

Instead, use the following shortcut key: Ctrl+Enter. (Hold down the Control key while you press Enter).

To view the page breaks you have entered, see Show/Hide in the section below.

Show/Hide | qr |

The Show/Hide function allows you to see hidden formatting codes—a helpful tool when you need to correct
or modify formatting. To find the Show/Hide icon,

1. On the Ribbon Bar, click the Home tab.
2.1n the Paragraph section of the Home tab, find the Show/Hide icon:
3. The Show/Hide icon is a toggle switch: Click once to turn it on, and click again to turn it off.

O\ HB9- 97 &) Document2 - Microsoft Word
3
/ Page Layout References Mailings Review View
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Paragraph
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The Show/Hide icon | q] | reveals the following codes:

SYMBOL MEANING

T Manual line feed
(Enter key pressed)

-+ Tab space entered

------- Spaces inserted (1 dot = 1 space)

----- Page Bresk . Manual page break inserted
(Ctrl+Enter)

@ SHORTCUT e SHORTCUT e SHORTCUT e SHORTCUT e

The Show/Hide icon also appears on the Quick Access toolbar, which is visible no matter what tab is

open.
) dBI (1Y & -
3
/ Home Insert Page Layout Refey
‘] “*  Times New Roman ~112 ~ A
]
Paste 7 B Z U -~ abe x, x* Aa~|*®
Undo

The Undo icon 9 - is located on the Quick Access Toolbar (see diagram). Clicking the Undo icon allows
you to cancel your last command (if you click Undo once ) or your last several commands (if you click
repeatedly). Make a mistake? Just click Undo!

/o NN G .qA, P B

Home Insert Page Layout Refe

i
(=)

_J “* Times New Roman ~112 ~|A

Paste j B I U ~abe x, X' Aa~||®¥

Remove Hyperlink

When you type a URL (Internet or e-mail address) and press the Enter key, the URL turns blue and
underlines, creating a hyperlink. Hyperlinks occur on your Reference page when you type URLs for
electronic sources. Hyperlinks must be converted to “normal” text:

1. Right Click on the hyperlink (click the right mouse button)
2. When the menu opens, click Remove Hyperlink.

URLSs (Internet addresses) appear on your reference page but should never be inserted as in in-text *
citations.
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INITIAL SETUP OF APA PAPERS See our E-learning videos at www.smumn.edu/tcwrite

Get started off right! Set up APA format before you begin typing. You can set formatting for your current
APA paper only, or you can change the default so that the formatting stays set for future APA papers. (You
can set the default back to MS Word's original settings at any time.) As you become more familiar with
Word 2007 for APA, you will find shortcuts for some of the tasks described in this section. The directions
below allow the option of changing your default settings so you won't have to keep reformatting

each time you start an APA

FONT (TYPEFACE)

The standard for APA (p. 212) and for student papers at Saint Mary's University is Times New Roman 12.
Underlining is never used in APA papers, Boldface and but italic are used for some headings. Setting the
typeface for a single paper is easy. Simply select the font and font size on the Home tab of the Ribbon bar.

FONT (Typeface)

To change the default setting for all
papers,

1. In the Font section of the Home
tab, click the arrow in the right
corner to open the Font Menu.

2. In the Font menu select settings
for
a. Times New Roman
b. Regular
c. 12

3. Click the Default... button at the
lower left.

4. When prompted by the menu,
click Yes to reset the default
setting.

5. Click OK to close.

Home

Times New Roman

Insert ut

References Mz

-[12 - ||AN AT ||

Cste J B Z U ~abe 3 % A%~ A -
Clipboard = Font @
Font W@

Fogt Chatacter Spacng

New Roman

Times - Ealiram
imes New Roman italc 9
— a Bold 10
raditonsl Arabic Sold Itale 11
Trebuchet MS T ¥,
Tunga v
Font golor: Uncerine style:
Automatc ¥ | | (none) v
Effects
[[] strikethrough [[] shadow [] smail caps
[J oouble strikethrough [ Qutine [ a¥ caps
[[] supsrsorpt [ gmboss [[] riciden
[ supscrot Clengrave

Previey

Times New Roman

This Is a TrueType font,

This font wil be used on both printer and screen,

You are about to change the default font to (Default) tme, 12pt.

Do you w change to affect all new documents based on the NORMAL template?
< )'es ] [ Cance! ]
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MARGINS

Margins must be set from the Page Setup section of the Page Layout tab. Do not try to set margins from
the Paragraph Setup section. Margins show be set at 1" on all four sides (except for doctoral students,

who use 1.5" on the left side).

MARGINS

To set margins and change
default,

1. On the Ribbon Bar, click the

Page Layout tab.

2. In the Page Setup section
the Page Layout tab, click
arrow in the right corner.

3. When the Page Setup
window opens, select the

of
the

Margins tab if not already

open.
4. Make sure all four margin
are set at 1 inch.

S

5. To make this the setting for

all papers, change the

default setting as follows:

a. Click the Default. . .
button at bottom left.

b. When the next window

opens, click Yes.

Doctoral students use a left
margin of 1.5"

¥*

N

) O,

Home

15!
a1 __

|y Orientation = ¥= Breaks -

Inzert |Pagc Layout | References

[ Size - #) Line Numbers.x
nes Margins
' rg 88 Columns = ¥ Hyphenati
hemes Page Setup (]

Docun

Mailings Rl
14 Watermark
A Page Color
[ Page Borders

Page Backgrouny

S ddB & o9 0

Para Keep With Nea £

Orientation

Al
Portrait  Landscaps
Pages
Mutple pages: |N:rmal

Microsoft Office Word

Q)

5)‘1‘5

J |

Mo

]

Do you want to change the default setiings for page setup?
This change will affect all new documents based on the NORMAL template,

L—

Apply to: |1"-'hl:|l! document

v
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TEXT ALIGNMENT, INDENTS, AND LINE SPACING

Perform settings before typing.

TEXT ALIGNMENT set at LEFT

2. In the Paragraph section of the Home tab,
Q’ click the arrow in the right corner.
. L 3. When the Paragraph window opens, click
dents s Soecing @wc PacaBreaks the Indents and Spacing tab if not already
open.
Genera @ 4. Set alignment to Left as illustrated.
<\ v

@ 1. On the Ribbon Bar, click the Home tab.
f h K

All APA text is aligned to the left margin,
except for centered headings and title
page, where the Center command is used.
Do not set alignment at "justified" to
Indentation make the right margin even. The right
margin should be ragged.

Left 0 = Special: By:
Right 0 & @ (none) v 4 INDENTATION set at 0 and NONE
i ‘ 5. All indentation 0 and "(none)" should
[ Mrror indents appear in the box as shown at left. To
) indent the start of a new paragraph, use
SPAc] the Tab key .
Before: 0pt = Line spacing: At: .
LINE SPACING is DOUBLE THROUGHOUT
After: @':‘ pt S ®D°v°e 2 ¥ 6. InAPAlines are double-spaced
[[] pon't add space between parsgraphs of the same style throughout—never more, never less
(except on some title pages).
Dreuin 7. If you find irregular spacing between
- paragraphs (usually an extra line), it is
Sremas Swarun e Sewywn Swas Swwrh e Se emas e because the "Before" and "After" spacings
Serge Tat Surgs Tet Sece Tet Sarge Tat Surge Tet Serce Tes Serve Tes Serde Te are not set at 0 as shown at left

Zavoe T Zavoe Tel Zavoe T Zavoe el ZavoeTe

SAVE SETTINGS (Change Default)
8. To save settings for current paper only,
click OK.

[ Tabs... ] @) Defauit... ] @) OK ] [ cancel 9. To save settings for future papers, change

the default setting as follows:

To change defaults on a Mac a. Click the Default . . . button at bottom

left.
1.first select Format, then Style, b. When the next window opens, click
then... Yes.

2.select New. ..,

3.name the new style APA Format,

4. set style type to Paragraph,

5.set "Style based on" to Normal,

6. set defaults as shown above for PC users,

7.check the box "Add to template," OK.

8. Now select Format, then Paragraph,

9. set defaults as shown above for PC users
10.click ok.
11.click OK in the New Style window.

Hanging Indents for references and indented
block quotes are explained elsewhere in this
booklet .

You will now be able to select your APA style from
the Style Bar.
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PAGE NUMBERS AND PAGE HEADERS [p. 230]

The APA manual calls for a page number and a running head, both inserted into the header box, %-inch
from the top edge of each page, including the title page.. and page headers on every page, including the title
page. Check to see if your program requires a different arrangement.

To insert page numbers and running head into the header. ..

1. On the Ribbon Bar, click the Insert tab .

2. Inthe Header & Footer section of the Insert tab, click the Page Number

icon. NOTE: Page numbers must be inserted before the header is typed.

When menu opens, click arrow for Top of Page selection.

4. Inthe new menu (not shown in diagram), click the illustration showing
page number at top right of page.

5. Page number will insert automatically in the header box and will keep the
header box open so that you can type your running head.

&Y

A running head is just a short form of the title appearing on every page
so that if pages get separated from the document, they can be
identified for reinsertion.

h -

) - 7 o I Documentl - Microsoft Word

o~
Cn

3 1

~ Page Layout References Mailings Review View

£) Cover Page ~ N ; 8. Hyperlink j - j
j — g Z :7‘ “ ,ZBookmark J :

_) Blank Page
i Table Picture Clip Shapes SmartArt Header Footer | Page ext
¥= Page Break v Art v Number~'| Box~
Pages Tables lllustrations Links m
i . 3
: ' Top of Page » |
6. After page number is inserted, type the running head to the left of it Bottom of Page >
no space between running head and page number. Pacie Matoins > |
G i |
DATA SECURITY1 Current Position »

Make sure header and page number Are set to Times New Roman
12 to match font of paper.

Format Page Numbers... |

PREED®D

Remove Page Numbers

7. With the cursor between the ruphing head and the pageumber, press
the Tab key as many times as ngeded to align the running hdad at the left
margin and the page number gt the right margin.

8. To exit the header box, doubfe click anywhere outside it. Page nuiqbers
and running head will appeAr on every page. Page numbers adjust a

revise.
/ " \ &
[).-\ TA SECURITY 1
| Header box. A

a_'LM-\ At srm s - JJ .A’r,-.-.\ L N *_N__.r“-. V e l- , SO S
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Keep Page Number and Header off First Page

To keep page number and header off title page (if instructor requests),

1. Insert page number and header as described above.

2. On the Ribbon Bar select the Page Layout tab.

3. In the Page Setup section of the Page Layout table, click the arrow in the right
corner.

4. When the Page Setup menu appears, select Layout tab.

Click the Different first page tab to insert a check.

6. Click OK at the bottom of the Page Setup box to close and return to document.

&

ParakeepWith Next 55 | & | 0 A - | | Header & FooterTools  Document2

L LDEHdR Q&
3

Home Insert Mailings Review View Acrobat Design

[ ‘\ | uColors b4 k - n Indent Spacing
['A' 2 | £ j ﬂ J 5 =
J [a]Fonts ~ ) Line Numbers ~ EE Left: 0 s || §= Before
Themes — Margins Orientatio§ Size Watarmark Page  Page L v | e
v |O]Effects ~ s v bé~ Hyphenation = Color~ Borders = EZ% Right: 0 S || = After:
Themes @ ‘ he Background Paragraph

[E— . T pu—
21

I Diftaseatfadd and even
©
Header: m
Footer: m

From edge:

INDENTATION: HANGING INDENTS AND BLOCKED QUOTES

Hanging Indents

Do not create hanging indents "manually" by inserting line breaks and tabs or spaces. If you do, you will not
be able to revise your reference page. Instead, follow the directions below to allow MS Word to insert
automatic hanging indents that self-adjust as you revise.

You can set hanging indents before or after typing the text. If you format hanging indents after typing the
text, you’ll need to highlight the text before formatting. You will also need to remove all Tabs, if you inserted
any, from the Reference list. (See Show/Hide in this section.)

Instructions for creating hanging indents are as follows:
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Hanging Indents

To set hanging indents before typing the first reference entry,

On the Ribbon Bar, click the Home tab.
In the Paragraph section of the Home tab, click the arrow in the right corner.
When the Paragraph setting box opens, click the arrow next to "Special:"
Select Hanging . The settings will look like this:
Special: By:
Hanging | | 0.5" |

= IR

5. Click OK to close.

When you type reference entries, just allow the lines to wrap and indent automatically.

Do not press the Enter button until you are ready to type the next entry.

J /& s Document3

(Oa) H B 2
[t |

Home

1

Page Layout

References Mailings Review View

N EREEE L]

@) F
j . Times New Roman * 11
= -3 P
=== &

Pa‘ste ¥ |B I U ~abe x, x* Aa~||?¥- A-|]|

A

2019 | AzBocer| Aa

T Hormal | T No

| Clipboard ™ Font IF] Paragraph IF] 2
S I D
g 1) aragrap
: Indents and Spacing Line and Page Breaks |
i General
. Alignment: Left v
Outline level: .Body Text v
Indentation
Left: o = Special: VWV By
: Right: v 3 '
’ [] Mirror indents
N Spacing
) Before: opt - Line spacing: at:
™ After: opt 3 'Double vl =

] Don't add space between paragraphs of the

Preview

lame style

Samgts Tews Samete Tt Samete Tens Samete Teas Semgte Teas Samgte T
Sumzts Tow Sumets Tos Samess Tous Samets Tous Samgis Tom Sumgis T
Sumcte T Sumcte Tom Samgts T Samsts Tow Suecte Toa

Simgis Tom Sampie Teas
Samgic Tom Samgis Tew

[ Tabs... ] [Qefau[t.n ]

X N Sl ]
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Indenting Blocked Quotes

Note: Use direct quotes sparingly, if at all. If you use a quote of 40 words or more, you must "block" that
quote as shown. Do not place quotation marks around blocked quotes (see APA pp. 118-119).

To create a blocked quote,

1. Type the quote, double-spaced.
2. Highlight the quoted text.
3. Click the Increase Indent icon on the Home tab of the Ribbon Bar:

rosoft Word

@ BlockQuoteExample -
Home | Inset  Pagelayout  References  Mailings  Review )

7y

& TimesNewRoman - 112 - [A &7|[&] [iE- 1=, AaBbCcl | AaBbCcl AaBbC: AaB
Paste

(B Z U-shex x A|¥-A-| EED

Font I ‘Paragraph

7 Normal |1 NoSpaci.. Headingl Head

Farmer (2005) pointed out that no evidence positively correlates good research techniques with
good research writing; in fact, the literature suggests a negative relationship. Farmer offered an
approach to bibliographic instruction in which research strategies are taught in a rhetorical

context, saying that

68 ©The Writing Center, Saint Mary's University of Minnesota Schools of Graduate & Professional Programs



COPY & PASTE APA REFERENCES FROM A DATABASE

NOTE: Much of the information below appears in video form at APA Citation Tutorials on our website
(www/smumn.edu/tcwrite, under "APA" > "APA Resources"->"APA Citation Videos").

Save yourself time by copying and pasting pre-formatted APA references from electronic databases right
into your reference list. Even if you don't find a pre-formatted reference, it is always easier to copy reference
information from your souce and paste in into your reference list.

The SMU Librarians have made the process of finding APA citations even easier by setting up SuperSearch,
which allows you to find sources in all the Saint Mary's database holdings through a single search. This
means that you will find standard APA citations regardless of the database in which the source resides.

Always begin by setting up an reference page in APA style with hanging indents: 1-inch margins, 12-
pt Times New Roman, double-spaced, automatic hanging indents Keep that document open while
you search for your sources. (Find help on the Writing Center web site at www.smumn.edu/tcwrite.)

Follow these steps to copy and paste an APA citation directly from the search screen to your pre-formatted
reference page.

1. Go to the Twin Cities campus library at www.smumn.edu/tclibrary and enter your
search terms in the SuperSearch screen.
2. Click Search.

s I/':‘x_l I .—\u\:I

Sedsching: SuperSearch

police and race and profile @
® Keyword O Tide O Author

b Search Options | Basic Search | Advanced Search | Visual Search | Search History

[continued next page]
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3. When the search results appear, click a title to open the full citation.

|_| operation of US syringe exchange programs. $2

Academic Database: EBSCO MegaFILE
Journal

Show al 4 images

|1 Add to folder

o
. POF Full Text (275KE)

The Right to Life?: Policing, Race, and Criminal Injustice. 5
Database: MasterFILE Premier

Periodical (=l Add to folder

o
= HTML Full Text

I~ The roles of law, client race and program visibility in shaping police interference with the

When the full citation window opens, you can read the article abstract. If you want to

use the article in your paper. ..

4. Click on the Cite button at the right of the screen.

{ResultList | Refine Search El 10f82 10

operation of US syringe exchange programs.

The roles of law, client race and program visibility in shaping police interference with the

Authors: Beletsky, Leol?
Grau, Lauretta E.*
‘White, Edward!
Bowman, Sarah!
Heimer, Robert? 22

Source: Addiction; Feb2011, Vol. 106 Issue 2, p357-365, 9p, 3 Charts, 1 Graph

[continued next page]
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5. When the Cite screen opens, you will find an APA option. Highlight and copy that
reference.

= Citation Format

NOTE: Review the instructions at EBSCO Support Site and make any necessary corrections before using, Pay special attention to personal names, capitalization, and
dates. Always consult your library resources for the exact formatting and punctuation guidelines.

S
AMA  Reference List
(American Medical  Belatsky L, Grau L, White E, Bowman S, Heimer R. The roles of law, client race and program visibiity in shaping police

AssoC.)  interference with the operation of US syringe exchange programs. Adgiction [serial online]. February 2011;106(2):357- —
365. Available from: EBSCO MegaFILE, Ipswich, MA. Accessed June 25, 2012,

(%AM Refarances
(American Psychological  pelatsky, L., Grau, L. E., White, E., Bowman, S., & Heimer, R. (2011). The roles of law, client race and program visibility

tion, 106(2), 357-365.

AsS0C.) i shaping police interference with the operation of US syringe exchange programs. Addic
doi:10.1111/§.1360-0443.2010.03149.x

|

Export to Bibliographic Management Software (Endote, ProCite, Reference Manager, RefWorks, BibTeX, etc.) »

Now paste that reference onto your reference page, noticing the Paste Options box that appears on your
document as soon as you paste (yours may look slightly different from the one below) ...

6. Click the small arrow to the right of that box to open the options.
7. When the Paste Options window opens, select Merge Formatting (or Match Destination Formatting), and
watch the reference transform to the formatting you set for your reference page.

RUNNING HEAD 17

References
Beletskyv, L. Grau, L E  White, E.. Bowman, 5, & Heimer, R_(2011). The roles oflaw, client
race and program visibilitv in shaping police interference with the operation of US

svringe exchange programs. Addiction, [06(2), 357-363 dei:10.11115.1360-

0443.2010.03149x
- 6
(Ctrl) =
e Options:
Pl ™ *5[% A - - /

G-

Ml <

|

Merge Formatting (M) |

[continued next pagel
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After you copy/paste the reference to your page, check to see if any APA corrections are needed.
Catelli, L. A. (2006). School-university partnerships for closing the achievement gap: Ethical

concerns. Journal of Educational Management, 20(3), 83-194. doi:
A
10.1108/09513540610654155

Don't worry about alphabetizing your references as you copy and paste. You can automatically
alphabetize when you finish. Here's how:

1. Highlight just the references (excluding page title and any extra line feeds at the end).
2.0n the Home tab of the ribbon bar, locate the Sort icon:

3. Click OK
\

RUNNING HEAD 17

Feferences

> Jones, A P & Frederickson, N. (2010). Multi-informant predictors of social inclusion for
students with autism spectrum disorders attending mainstream school. Jowrnal of Autism
and Developmental Disorders, 40(9), 1094-103. doi:10.1007/510803-010-0957-3

Catelli, L. A. (20060). School-universitv partnerships for closing the achievement gap: Ethical
concems, Jownal of Educational Management 20(3), 83-194. doi:

@ 10.1108/09513540610654153

Beletsky, L., Grau, L. E., White, E. Bowman, 5., & Heimer, B (2011). The roles of law, client
race and program visibilitv in shaping police interference with the operation of US
svringe exchange programs. Addiction, [06(2), 357-365. doi:10.1111/5.1360-

0443.2010.03149x

>

R I I LY T L N N e R

Need help with SuperSearch?
The friendly SMU Twin Cities librarians are always ready to help!
www.smumn.edu/tclibrary
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MATCH REFERENCE ENTRIES TO IN-TEXT CITATIONS:
Shortcut with "Find"

You know that every reference on your reference page must be cited—and cited correctly—in your text. In a
very short paper, this is easy to do. In a long paper, however, especially one with many in-text citations,
matching your references and citations can be quite a challenge. Let the word processor's Find function
help you.

1. With your reference page open on your screen, click the Home tab.

2. Drag the mouse to highlight the last name of the first author in your first reference. When you
highlight, be sure to catch only the first name—no comma and no initials.

3. With the name highlighted click the Find icon near the top right of the Ribbon Bar, and select Find
from the menu.

4. You will now see a navigation menu to the left of your reference page.

Too Insert Page Layout Referances Mailings Pvidw Vigw
o)

_-I ®  Times NewRoma = |12 = A - B i=.4=-tz R4 .
Boon U itle Change
e 4 BT U vk ox X w-A-|EE AN E | Sees v | W Select
2 )| | Dy 9 = &5 [ Pars Keep With Next 5 TR T lopt

v;[L_:T':'. A

K -

5 matches . o
3 jj. . @ .D..Cruce, T. M.. Sh

factors that ndluen
students’ achievernent gh
Cruce, Shoup, Kingie, &
Ganyea, 2008; Rugutt & Make sure i -

' the Results Education, 79(5), 540

of student engagemen

tab is

the supportiie envirgnment
created by peers. Kuh &t al
(2008) reperbed that students
became

_SeleCted- bnski, S. T.. & Lubienski

background and math etrieved

equal ¥ achvanta gecus o the
college classroom (Muh et

[continued next page]
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The Navigation Screen

5. Your in-text citations appear in the Navigation screen in the order in which they appear in your text.
Check each citation for correctness. The last listing in the Navigation pane is always the reference list

entry, not an in-text citation.

¥ Make sure

In multi-authored works, make sure all authors
are named (up to six authors) in the first  —

In subsequent citations, use only first name,

followed by et al. If there are only two >
authors, be sure to name both authors every
time.

Be sure that the year follows the name. R ——

The last one is always your reference page entry,
not a text citation.

Navigation

Kuh

5 matches

oo
oo

factors that influence
students’ achievement (Kuh,
Cruce, Shoup, Kinzie, &
Gonyea, 2008 Rugutt &

the supportive envirenment
created by peers. Kuh et al.
(2008} reported that students
became

equally advantageous to the
college classroom (Kuh et
al., 2008). A senze of
community can create

due to their characteristics
and demographics. Kuh et
al. (2008) showed that

student success was

v

Kuh, G. 0, Cruce, T. M.,
Shoup, R, Kinzig, 1., &
Gonyea, R M. (2008).
Unmasking the effects of

the Results
tab is
selected.
- Kuh. G
Lubiens
™ ‘|
McKint
NI Nonoyd
Y,

74
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6. To begin the search for the next entry simply highlight first author in the next entry and click Find. The
new name will appear in the Navigation screen search box.

7. If you find an entry for which no in-text citation exists, you must either remove the entry or provide a
citation for it in your text.

8. Keep in mind that that you will still have to locate citations in your paper that you may have forgotten to
include in your references. Every citation in the text (except personal communcations) must have a
reference list entry. You can use the "Find" function to check your in-text references to make sure
they are listed on your reference page. Just look for the last item in the navigation screen and
make sure it is a reference list entry, not another in-text citation.

Navigation ¥ X @Jl' T S 1
Pasaue x -l 57-82.doi:
1 match -
SEIE - v |l Pasque.P. A., & N
Pasque, P. A, & Murphy, R. n . -
(2005). The intersections of 2 ldentlt}“ as
living-learning programs
and social E .
_ College St
T : http://searc
The last one is always your reference page entry, =

not a text citation. If you don't see an in-text
citation for it, remove it from your reference page
or cite it in your text.

Get Help With APA Citations and References

>> Publication Manual of the American Psychological Association: Chapters 6 and 7, but especially
Table 6.1, p. 177, and pp. 184-187

>> Introduction to the APA, pp. 11-32

>> APA Style Blog Use its search box

>> E-Learning Modules SGPP Writing Center's newest online feature

>> Make an Appointment for a consultation in person, by email, or by phone.
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LISTS: BULLETED OR NUMBERED

Use numbers when the order of the items is important—for example, in presenting a set of ordered steps in

a process. Use bullets when the order of items is not a factor.

* Numbers and bullets should be ¥ inch from the left margin, in line with paragraph indents.

Items in lists must be grammatically parallel.

Lists are double-spaced like the rest of the text.

Use lists to summarize. They should not replace a detailed explanation or commentary.

Efaence@'hﬂmc 5 Rev |Eu®ew Add-Ins
- Aal A .
Aa ./. ’ AaBbCcDa A

Bulleted or Numbered

¢ Kirjoita luettelon (ilman luettelomerkkeid) ja korosta se
¢ Valintanauhan baarissa-napsauttamalla Aloitus-vililehd

o  Valitse luettelomerkin kuvaketta uudelleen luettelomerl

luettelomerkkien poistaminen kiytosta.

* Viivain-palkin, (mutta luettelossa nikyy edelleen korost

Lists
W-A-|EE == 0= Ernphasis H
1. On the Home tab of
i Paragraph the Ribbon Bar, click
[ Para Keep With Next % | | 0pt * 0pt : = the Bullet icc')n (or
R . : : . the number icon).
Ll

- —_ —_
& — F—

- —

2. Type the list, then
highlight the list.

3. On the Home tab of
the Ribbon Bar, click
the Increase Indent
icon to move the list
until the bullets (or
numbers) are % inch
from left margin, in
line with paragraph
indents.

-E
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About the Ruler Bar . . .
The ruler bars runs the width of the editing screen and is located beneath the Ribbon Bar.

If the Ruler Bar is not showing on your screen, turn it on as follows:

1. On the Ribbon Bar, click the View tab.
2. Inthe Show/Hide section of the View tab, click the Ruler Bar box.
3. An alternative way to turn the Ruler Bar on and off is to click the icon on the far right of

the Ruler Bar, at the very top of the scroll bar.

Page Layout References Mailings Review Acrobat Format

‘J @ Document Map { J) One Page s | % j ) View Side by Side
_J ! «m: = ,

nidlines Thumbnails == 24 Two Pages

line Draft Zoom 100% New Arrange Split
¥ < Page Width | window Al
Show/Hide Zoom Window
. A E _‘ i 7 a
k.......4d Grey areas of Ruler Bar indicate document margins ~ “trsresreseesnesens

/\ RULER BAR /\

To indent with the toolbar,

1. Place the cursor where you want to begin the indent.
2. Drag the indenting "hourglass" on the Ribbon Bar to the appropriate % " marker.

Note that the "hourglass" is divided into 3 sections that can be dragged separately. Refer
to the drawing at right to select the appropriate segment of the "hourglass" to drag.

Parts of the "Hourglass"

Drag upper triangle to indent first line of paragraph.

Drag lower triangle to indent subsequent lines of
paragraph.

Drag square to move both triangles. To indent a
block of text, highlight the text and drag the square.
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WORD COUNT

To count words quickly,

1. Highlight the text containing the words you want counted.

2. Look near the bottom left of your screen. You will see a ratio: on the left is the
number of words you highlighted; on the right is the number of words in the
entire document.

. should describe it as a wa
scholars present ideas for
beginning researchers fin

community of scholars. (j

w

Page:1of 1 . | &

ALPHABETIZE
To alphabetize quickly,
1. Remove any extra blank lines after the last entry.
2. Highlight the reference list (but not the title).
3. On the Ribbon Bar, click the Home tab.
4. In the Paragraph section of the Home tab, find and click the "sort" icon:
5. When the sort menu opens, make sure settings are as follows:
Paragraph . . . text . . . ascending
6. Click OK.
3 )
@ Insert Page Layout References Mailings Review  View
= 4
& Calibri (Body) 11 - A A'||A')| =k =il

o |
g B Z U-aex x A |¥V-A E=EFEE|S| O L 3
A fs Paragraph o
Sort Text _?Iﬂ*'
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"ORPHAN" HEADINGS (For an explanation of APA heading styles and formatting, see the Writing
Center's Introduction to the APA and Other Writing Tips as well as the APA manual, pp. 111-115.)

Headings that stand alone on a line can get separated from their text when they occur at the bottom of a
page. (Turning on widow/orphan control won't help with headings.) The following procedure will ensure that
headings remain with the text that follows them.

NOTE: Do not use this command with APA Level 3, 4, and 5 indented headings. Use it only for
headings that appear alone on aline.

To prevent heading from separating the their text. ..
1.
2.
3.

On the Ribbon Bar, click either the Home tab or t

corner.

When the Paragraph menu opens, click the Line
Click to place a check in the Keep with next box.
. Click OK.

Place the cursor in front of the first letter of the heading (or before you type the heading).

he Page Layout tab.

In the Paragraph section of the Home tab or Page Layout tab, click the arrow in the right

and Page Breaks tab.

Insert Page Layout References Mailings

Times New Romar » 1

B 7 U -abs x
¥ u

View

Add-Ins

daBbCcDa  AaBbCcl

Emphasis T Heading 3

¥*

Clipboard Font Paragraph
~ N

H B : 0 &&= : u‘é‘é I3 : 2y~ 9 - D Para Keep With Next ":? 5] Ir

1] ) |

time therapists spend away

drain will be better position|

G

friends, encompassing relat

Saocial support.

and secondarv trauma.

professionals working with
important component in ma
demonstrated between soci
quantitative analvsis condu
satisfaction mitigated risks
City following the Septemb
tolow levels of stress and a
2003). Social support appel
trauma.

Organizational Strategies

\ 4

V(O

Indents and Spacing | Line and Page Breaks

Pagination
Widoysrphan control
[ keep lines together

[ Page break before

Tabs... l lSet Ags Default ] [ QK l [ Cancel
e SHORTCUT e SHORTCUT e SHORTCUT e SHORTCUT e
To avoid repeating the steps above every time you type a title, you can place an icon on
the Quick Access toolbar that completes the steps with a click of a button. See the
section called "Customizing the Quick Access Toolbar."
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CUSTOMIZE AUTOFORMAT SETTINGS

Word 2007 is installed with auto-format settings that may be inconvenient for APA papers. You can easily
change these settings. Customizing for APA or for any auto-format that suits you. Autoformat changes will
be maintained for all documents until you change Autoformat again.

For example, many people are annoyed by "check-spelling-as-you-type" and "check-grammar-as-you-type"
auto-format settings, which place red and green underlines on the screen to indicate possible errors.

You can turn off those as-you-type settings and select Spelling and Grammar from the Review tab when you

are ready to check.

To change an auto-format setting,

1. Click the Office Icon at the far top left of the screen .
2. When the Office menu opens, click Word Options at the bottom of that menu.

3. When the Word Options menu opens, click the Proofing button on the menu at left.

4. When the menu opens, click off the boxes for Check-spelling-as- you-type and for Mark-

grammar- errors-as-you -type.
5. Click OK to close.

Other AutoCorrect options are available from the same menu (see "AutoCorrect Options..."

button near top of menu)

99v & °

Recent Documents

Model Paper
StudentsiearnGroups
InitialSettings_Font
Hanging Indent
InitialSettings_Page_Part 3
InitialSettings_Page_Part 2
InitialSettings_Page

0 IN KDY W e W N e

InitialSettings_Paragraph

Word2007Screens

R
Y| Prepare pNictice apa

K ag Send »
Pyblish »

b

Close

*) Word Optiol

To run the Spell Check and
Grammar Check manually . . .

1. Click the Review tab
2. To the left of the Review

Word Options

Popular

Proofing
Save
Advanced
Customize
Add-Ins
Trust Center

Resources

©

ABC|
gy ; Change how Word corrects and formats your text.

AutoCorrect options
Change how Word corrects and formats text as you type: | AutoCorrect C

When correcting spelling in Microsoft Office programs

Ignore words in UPPERCASE

Ignore words that contain numbers
Ignore Internet and file addresses
Flag repeated words

D Enforce accented uppercase in French
[C] Suggest trom main dictionary only

Custom Dictionaries...

French modes: | Traditional and new spellings v

When correcting spelling and grammar in Word

D Check spelling as you type
[[] use contextual spelling

Check grammar with spelling
] show readability statistics

Writing Style: | GrammarOnly
Recheck Document

Exceptions for: '.—:JJ WordOptions_toAutoFormat v

ribbon, click this icon:

v

Spelling &
Grammar
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DOT LEADERS FOR TABLE OF CONTENTS

APA provides no guidelines for a table of contents; however, some instructors do require one. Generally a
table of contents calls for dot leaders—rows of dots from entries to their page numbers, like this:

Statement Of the ProbIEmM ...t aeeaes 3
RESEAICh QUESTIONS ...ttt e e e e e e e e e s st a e e e e e e s et b rbeeaeeesaaannees 4
(DT (gL 1 Lo T T L =T 4T PPN 5

To make your page numbers line up on the left (and to spare yourself typing hundreds of dots), you must set
up dot leaders for your tab stops. Dot leaders automatically insert dots when you press the tab key, and the
dots adjust automatically to give you a straight column of page numbers on the right. To create a table of
contents . . .

1. Type the title Table of Contents, no boldface, centered, at the top of your page. The table of contents
should be double-spaced like the rest of your paper.

2. Open the Tab menu as follows:

a. On the Ribbon Bar, click the Home tab.
b. Open the Paragraph menu (click the arrow inside the Paragraph section of the Paragraph
Section. |[= = = = I| = v|| b IR

Paragraph

c. From the Indents and Spacing menu, click Tabs at the bottom of the menu.

Paragraph

Indents and Spacing ) Line and Page Breaks

General

== = I
[ Tabs... ] [ Default. .. ] I Ok ] [ Cancel ]
Tabs  [?]x]
3. Set dot leaders as follows: N
Tab stop position: Default tab stops:
d. Clear All Tab stops (default tab stays). i@ 0.5 3|
e. Type Tab stop position: 6.5 Tab stops to be deared:
f. Select Alignment Right.
g. Select number 2 dot leader.
h. CLICK Set. Don't overlook this step. Alignment
O Left () center {¥) Right
. Cllck Ok. {:} QECiITIEII C} Bar
Leader Start
NOTE: By setting dot leaders, you turn the Tab O 1None ®2...... ) 3 —— here
key into a dot leader command. You cannot O ; - - ‘l’
now use the Tab key to indent subheadings in T
the table of context. Instead, use the Increase [ get ( e ﬂ Clear ] [ Clear &ll( a
Indent icon as shown below.
[ QK ( fi ’[ Cancel
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Indent Subheadings in the Table of Contents

If your table of contents contains subheadings, you cannot indent them with the Tab key, which now inserts
dot leaders.

To indent subheadings without dot leaders

1. Click on or highlight the heading
2. Click the Increase Indent icon on the Home Tab of the Ribbon Bar.

\
“aferences Mailings Review Wiew Add-Ins
{':‘
!

S - CO ETRI SN

J i Paragraph ] ;

Statement of the Problem ...........uuuiiiiii e rerersrerararaane
Research Questions
Definition Of TEIMIS........uiiiiii e
History of the Charter School Movement
Urban Changes .......ccuuviiiiiiie ettt

Inner City Crises.... .

Private INItIAtIVES ......cooiiiieice e

—mm= =1 LeISIAtioN ...

t } Indent with Increase Indent icon: ‘EE

CUSTOMIZE THE QUICK ACCESS TOOLBAR

The Ribbon Bar in Word 2007 cannot be changed; however, Word 2007 does allow customizing of the
Quick Access Toolbar. In its default setting the Quick Access Toolbar is located above the Ribbon bar and
contains only a few icons:

41

of) d9-0
- Home Insert Page Layout References Mai

Times Mew Roman 12 || A A2 ]2

You can add any icon that makes word processing easier for you. Even if the icon already exists on the
Ribbon Bar, you may find it more efficient to use it on the Quick Access Toolbar. Customize it in a way that
works for you. It's easy to remove an icon from the Quick Access Toolbar: just right click on it and select
"Remove."

The directions that follow explain how to move the Quick Access Toolbar to a more convenient location and
how to add quick-commands that make academic writing tasks faster and easier.
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Sale- Unic ch
3 u =/
v
Click on the arrow for
customizing options
v
v

Customize Quick Access Toolbar

Mew

Open

Save

E-rnail

Quick Print

Print Preview and Print
Spelling & Grammar
Undo

Redo

Draw Table

Open Recent File

Opens a menu of toolbar options ————= [Mare Commands...

To add a command icon to the Quick Access Toolbar,

illustration previous page).

Moves toolbar below Ribbon

Show Above the Ribbon €——— Bar for easier access

. Click on the arrow to the right of the Quick Access Toolbar to open the Customize menu (see

2. On the Customize menu, click More Commands . .. (see previous page).
3. When the Word Options menu opens (see below) select All Commands.
4. Make a selection from the menu and click the Add>> button .
5. Use the arrow buttons to move the command to the desired position on the toolbar list.
6. Repeat Steps 4 and 5 as necessary.
7. Select the "For all documents (default)" option.
8. Click OK to close.
Word Options
Popular @ Customize the Quick Access Toolbar and keyboard shorteuts.
Display
_ '\ghoose commands from: i Customize Quick Access Toolbar: (i
Proofing < 3 nAII Commands b | For all documents [default) w
Save -
Advanced - Pa;e Setulp m H save
[ﬁ Ij Page Size » ¥)  Undo 4
Customize _{.} Page Up 3 Redo
addns Page Up Extend v Para Keep With Next
Trust Center S Page Width
Pages -
Resources @ Panning Hand
Para Down
Para Down Extend
y Para Keep Lines Together 4 ‘ 5 ) E]
Para Keep With Next
Para Page Break Before
Para Up
Para Up Extend -
Para Widow Qrphan Control
5: Paragraph
Paragraph -
Paragraph Indent & Spacing -
% Parallel
[# Password (Web Control}
& Paste
[ Paste 3
(3 Paste as Hyperlink v
|:| Show Quick Access Toolbar below the Ribbon
Keyboard shortcuts:
Ky[ O ] [ Cancel
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Remove a Command Icon from the Quick Access Toolbar

1. On the Toolbar, right click on the Toolbar icon.
2. Select Remove from the Quick Access Toolbar

CORRECT IRREGULAR LINE SPACING

Problem

Cutting and pasting between documents can upset the line spacing of your document, sometimes leaving
three lines rather than two between paragraphs, as shown in the example.

Remedy

The extra line space cannot be r
by changing the line spacing to double.
Instead, change the setting as follows:

1. Highlight the text you want to change.

2. From the Home Tab of the Ribbon Bar,
open the Paragraph box.

3. Set the Before and After boxes to 0.
(Line Spacing should already be set at
Double.

4. Click OK to return to document. You
may need to readjust spacing.
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Saint Mary's University of Minnesota
Schools of Graduate & Professional Programs

THE WRITING CENTER

The SGPP Writing Center is staffed by three writing professionals, all of whom hold graduate degrees. All are
experienced at teaching research writing and ESL. The Writing Center is located in LaSalle 128 and open Monday
through Friday 10am-9pm and on Saturdays from 10am to 3pm. Call the Writing Center at 612-728-5154 (toll free 1-
866-437-2788, ext. 154) or email tcwrite@smumn.edu. The Writing Center is web site is at
www.smumn.edu/tcwrite.

SERVICES

1. Individual student consultations are designed as dialogues between you and a consultant to address

individual writing issues in the context of the your current paper. Consultations are free.

1.

You can have your consultation in person, by email, or by telephone. Consultations usually require an
appointment. With 24-hour notice, you can make your own appointments from our web site. To make
an appointment with less than 24-hour notice, call or email the Writing Center to arrange an
appointment. Read the Writing Center policies and practices (below) before arranging a consultation.

You are entitled to a maximum of 1 hour per week, 2 hours per paper, as appointments are available. If
you need more time in the Writing Center, we can make arrangements after consultation with your
program director or instructor.

2. Fee-based student workshops, offered each semester, target the following topics:

1.
2.
3.
4.

SSVC300 Introduction to the Basics of APA Source Citation
SSVC175 Microsoft Word 2007/2010 for APA (PC users)
SSVC235 Punctuation: Just Commas

SSVC200 Resume Writing

These workshops require registration at the Writing Center web site at www.smumn.edu/tcwrite. Workshops last
from 3 to 4 hours. The charge is $50 per workshop or $75 for two workshops in the same semester. Students
who attend workshops receive a current copy of the Writing Center booklet, Introduction to the APA.

Students who take courses either online or at a location outside Minneapolis can find some of the
workshop content in computer-based learning modules at our web site as follows (click hyperlinks):

Introduction to APA Citation Style MS Word 2007-2010 for APA Format (PC & Mzc Users)

How to Copy APA References from Databases MS Word 2008 for APA Format (Mac Users)

3. Online writing resources are available on our web site at www.smumn.edu/tcwrite. These resources include

the following:

1. Forms of writing provides guidelines for common writing assignments such as summaries, article
critiques, annotated bibliographies, and literature reviews.

2. Templates for formatting papers in APA style (on menu under APA[JAPA Templates).

3. E-learning modules, are short (2-4 minute) interactive videos on subjects in two major categories: (a)
APA style, (b) word processing for APA for both PC users and Mac users.

4. Link to the APA Style Blog takes you to the APA organization's own web site, where you will find an
excellent beginners' tutorial on APA style. The APA blog provides style updates and editors' responses
to questions submitted by APA users.

4. |Introduction to the APA is a an 80-page supplement to the APA manual developed by the Writing

Center and sold in the Saint Mary's book store for $5. (It is the required style manual for students
enrolled the undergraduate professional programs.) The booklet provides an introduction to the
Publication Manual of the American Psychological Association as well as general writing tips.
It also offers directions for using Microsoft Word for APA. You can view the booklet electronically at our
web site, under APA-> Resources.

POLICIES AND PRACTICES
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Consultants will answer questions, provide informed feedback as a reader, and make suggestions when
appropriate. Consultants are not allowed to proofread entire student papers, but they can help you identify
some of your writing problems, help you improve your proofreading skills, and teach you to correct your own
errors. You will take an active role in the review process and assume responsibility for final decisions.

Writing Center consultants' student session notes are in most cases kept confidential. However, in a case in
which an instructor detects plagiarism in a class assignment, the Writing Center director may release the
consultant's session notes to the student's program director.

Student Responsibilities

Part 1: Prepare For Writing Center Appointments

Face-to-face appointment, bring the following:

A print copy and electronic copy (USB drive or email) of your paper or draft,

A list of questions you want answered: What do you want to accomplish during your session?
A copy of your instructor's assignment guidelines ,

Your APA or AMA style manual,

Information about your sources as explained in Part 2 below.

Email appointment, do the following:

1.

2.

5.

Submit an electronic copy of your paper or draft. Upload your paper by clicking on the yellow
"folder" icon at the top left of the Writing Center schedule.

In the comment section of your appointment, provide a list of questions you want answered:
What do you want to accomplish from your email appointment?

If possible, provide a description of your assignment instructions or attach a copy with your
paper.

Our responses contain references to your style guide, so please tell us which you have: (a)
Publication Manual of the American Psychological Association (6th ed.), (b) Introduction to the
APA, or (c) American Medical Association Manual of Style.

Provide information about your research sources as explained in below.

Part 2: Disclose Your Outside Sources

1.

If your paper requires outside sources, you must provide retrieval information for each source
(author, date of publication, title, publisher information or URL).

You must give an APA citation (author date) in your paper wherever you include information from
an outside source. The Writing Center consultant will help you with APA citation style .

If you use phrases directly quoted from an outside source, you must place quotation marks around
the quoted words. Writing Center consultants, must be able to distinguish text that you composed
from text that was composed by another author.

Writing Center consultants may decline to help you with a research paper for which retrievable sources have
not been identified. If you need more information about providing sources, call or email the Writing Center
before your appointment so that a Writing Center consultant can provide you with additional explanation.
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Abstract, how to write, 57
Active & passive voice, 53
Alignment from margin, 1, 64
Alphabetize references, 78
APA, what is it?, 1
Apostrophe, 31, 45
Author element, 11
author missing, 12
authors, multiple, 15
Backspace & delete, 59
Book
chapter in authored, 14
chapter in edited, 15
translated, 14
Books, 13-15
Bulleted lists, 39, 76
Capitalization rules, 30, 47
Citing sources
Where to cite?, 9
Why cite?, 9
Citing sources in your paper, 25-28
anthropomorphism, 28
multiple authors, 25—-26
personal communication, 28
purpose, 25
relationship to reference page, 25
running text vs. parenthetical, 27
vary the citation wording, 27
where & when to cite, 25
Colon, 31
Comma, 31
Copy APA reference from a database, 69-72
Customize
autoformat, 80
Quick Access Toolbar, 82
Dash, 33, 59
Datamonitor, reference, 20
Date element, 11
Default settings, 62, 63, 64
Delete, 59
hyperlinks, 61
space between lines, 84
DOI Numbers, 23
Dot leaders, 81
EDGAR database, reference, 20
ERIC database, 18
Flow, how to improve it, 43
audience awareness, 43
consistency, 43
headings, 35, 43
organization, 44
parallelism, 44, 49
pronouns, 43, 51
quotations, limit, 43
quotes, limit, 5
repetition, 44
transitions, 43, 53
verb tense, 45, 55
wordiness, avoid, 44, 55
Font, 1, 62

http://sgppinet.smumn.edu/library/wc/APA 6th/Intro_To_APA_6thEd/IntroAPA_6th_2014-07-25.docx

INDEX

Format of an APA paper, 1
alignment, 1, 64
font (typeface), 1, 62
headings, 2
indents, 2, 64, 66, 68, 82
line spacing, 2, 64, 84
margins, 2, 63
page numbers, 2, 65, 66
spacing after punctuation, 2
Four elements of a reference, 11
Gale Virtual database, reference, 19
Grammar check, 60
Hanging Indents, 66
Headings, 2, 35-39, 79
1-level example, 36
2-level example, 36
3-level example, 37
4-level example, 38
about, 35
in the appendix, 39
prevent orphans, 39, 79
Hyperlink, turn off, 61
Hyphen, 33
|/ we, 52
Indents, 2, 64, 66, 68, 82
Legal documents, 22
Library databases, reference, 19
Line Spacing, 2, 64, 84
Lists (Seriation)
bulleted, 39
how to format in Word, 76
lettered, 39
numbered, 39
Map, electronic, reference, 21
Margins, 2, 63
Missing element (reference), 12
Motion picture, reference, 20
MS Word 2007 for APA, 58-84
alignment, 64
alphabetize, 78
autoformat, customize, 80
backspace & delete, 59
center, 59
customize
autoformat, 80
quick access toolbar, 82—-84
dashes & hyphens, 59
font, 62
general tips, 59
grammar check, 60
headings, prevent orphans, 79
hyperlink, remove, 61
indents, 64
block quotes, 68
hanging indents, 66
irregular line spacing, correct, 84
line spacing
correct irregular, 84
line spacing, 64
margins, 63



page breaks, 60
page headers, 65

page number, keep off 1> page, 66

page numbers, 65
quick access toolbar, 82—-84
ruler bar, 77
show & hide, 60
table of contents, 81
undo, 61
word count, 78
Numbered lists, 39, 76
Page breaks, 60
Page numbers & headers, 2, 65, 66
keep off title page, 66
Parallelism, 49
Paraphrases, 7-8
Parentheses, 33
Periodical, 16
journal article, 15
journal from Website, 17
newspaper article, 16
newspaper editorial, 16
Personal communication, 28
Plagiarism, 5
Primary & secondary sources, 10
Pronouns, 50-52
it, unspecified, 51
this,that,these,those, 51
we, us, |, they, them, 52
which,that,who, 51
you, 51
Publisher element, 12
Punctuation
apostrophe, 31
colon, 31
comma, 31
dash, 33
hyphen, 33
parentheses, 33
guotation marks, 33
semicolon, 33
spacing with, 31

with transitions & conjunctions, 52

Quotation marks, 33
Quotations, 5
blocked, about, 6
blocked, create in Word, 68
capitalization in, 6
effective use, 5
Reference page, 11-24

alphabetize references quickly, 78
author & publisher are the same, 14

author element, 11

author, missing, 12

authors, more than two, 15
basics of citing sources, 9

blog, 21

book, chapter, 14

book, chapter in edited book, 15
book, print, 13

book, translated, 14

copy APA reference from database, 69-72

Datamonitor database, 20

date element, 11

DOI numbers, 23

DVD, 20

EDGAR database, 20

electronic sources, 16-20

ERIC document, 18

format and arrangement, 13

four elements of an APA entry, 11
Gale Virtual Reference database, 19
journal article, library database, 19
journal article, print, 15

journal article, website, 17

legal references, 22

map, website, 21

match references to citations, 73—-75
motion picture, 20

newspaper article, 16

newspaper editorial, 16

primary & secondary sources, 10
publication date, missing, 12
publisher element, 12

title element, 11

title, missing, 12

titles, how to format, 29

URLs, 22

website document, 17

Research question, 57

Ruler

bar, 77

Secondary sources, 10
Semicolon, 33
Table of contents, 81

indent subheadings, 82

Tables & figures

citing, 40
format, 41

Tense of verbs, 55
Thesis, 57

Title element, 11
Title page, 2—-4

Titles

capitalization, 30
in your paper, 29
on the reference page, 29

Transition words & phrases, 53

URLs

for websites, 22

Verb tense, 55
Video (DVD), reference, 20
Website sources, 23

Word

blog, 21

Datamonitor, 20

document, 17

EDGAR database, 20

ERIC database, 18

Gale Virtual References database, 19
journal article, 17

library databases, 19

map, 21

count, 78

Wordiness, how to avoid, 55-56
Writing Center services & policies, 85
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